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How To Use This Manual 

This manual is divided into several parts that explain how to get the most out of 
Desk.Mate. Some parts are designed to be used as learning aids and others as reference 
tools . First, familiarize yourself with "Getting Started," and make copies of your 
Desk.Mate diskettes. Next, turn to the Sample Session and practice using all of 
Desk.Mate's applications, or just work through those portions you want. When you 
are experienced in running Desk.Mate, you will use the Reference part almost 
exclusively. 

About the Parts of the Manual 

Getting Started-Lists Desk.Mate's applications and equipment requirements. Explains 
how to load DeskMate, choose the keyboard, mouse, or joystick as your device; 
and make copies of your diskettes. 

Sample Session-Provides detailed examples designed to help you become comfortable 
with running Desk.Mate. 

Reference-Gives detailed instructions about using the keyboard or the mouse/joystick 
to move around on the screen and provides information about DeskMate's Main 
Menu and each Desk.Mate application. 

Appendices-Includes technical information for those who want to utilize the 
capabilities of DeskMate more thoroughly, a list of error messages, a glossary of 
terms, and technical information for the Telecom user. 

Index-Provides quick access to all parts of the manual. 

Conventions Used in the Manual 

Information that appears on the screen is printed in blue. 

The information that you are asked to " type" is printed in boldface. 

The Sample Session presents information in steps, noted by blue boxes. Accompanying 
the steps is extra information to help you with the instructions. For example: 

Place the cursor near the center of the screen. 



Haw to Use This Manual 

Keyboard: Move the cursor to the center of the screen and p ress the space bar . 

Mouse/Joystick: Move the cursor to the center of the screen and. click. 

As you become more familiar with DeskMate, you might want to skip the extra 
information. When you first start the Sample Session, however, read all the information. 
You can also refer to the Quick Reference Card packaged with this manual if you need 
help moving around on DeskMate's screens . 

You' ll often be asked to press combinations of keys, such as CALIJG). When you see 
two keys together, hold down the first key, and gently press and release the second key. 

The screens shown in the manual are examples only and may not exactly match your 
computer screens. 

Icons (like those on the screen) are used in many places in the manual to clarify 
instructions. 
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Introduction 

DeskMate® is a comprehensive package of easy-to-use applications for your Tandy 
Color Computer. Even if you're a computer novice, you' ll be at ease with the· most 
sophisticated application; and if you're an experienced computer user, you'll appreciate 
DeskMate' s versatility and managability. A complete workstation is now at your 
fingertips ... a desk calendar, typewriter (and even a way to " mail" a message or 
letter!)., filer, ledger, a "canvas" and an array of brushes and tools to paint a rainbow 
of colors-all with your Tandy Color Computer DeskMate! 

DeskMate features six major applications and seven subfunctions, any of which can 
be used at any time throughout DeskMate. Below is a description of each application. 

Calendar An event-scheduling system that lets you set up or review your schedule 
for any day, month, or year. 

Text Editor A general purpose text entry and editing application . You can also 
transmit text files via the Telecom application. This application also 
features an 80-column format option. 

Filer 

Paint 

Ledger 

Telecom 

A personal filing system with which you can create "index card" forms, 
enter or edit data, and sort and search for any of that data. 

A 16-color " picture" editor that enables you to create graphic screens. 
You can create lines, shapes, fills or patterns; enter text; and print your 
creation with a dot matrix or ink jet printer. 

A spreadsheet program featuring automatic column formatting. You can 
use the 80-column format option with Ledger. 

A communications application designed primarily for use with computer 
services and for transmitting or receiving Color Computer Desk.Mate data 
files. The 80-column format option is also available when you use Telecom. 

To use Desk.Mate, you need: 

• A 128K Tandy Color Computer 3 (second disk drive recommended) 

• Color Monitor or Standard TV set (color recommended) 

Note: The 80-column format option is not available if you are using a TV set. 
(Use the 80-column option only with a color monitor.) 
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Introduction 

To add to DeskMate's versatility, you can add: 

• 

• 

• 

Joystick or Mouse 

A second disk drive 

Any printer with a serial port (for example, a dot matrix, daisy wheel, or ink 
jet printer) 

Note: You cannot use a Daisy Wheel printer for printing pictures you create 
with the Paint application. 

To use Telecom, you must have: 

• A standard modem 

• RS-232 Program Pak 

• A Multi-pak Interface 

Connecting Equipment 

Connect your equipment according to the instructions in the manual(s) that came with 
it. To use Telecom, set up your equipment as instructed in Chapter 18, "Telecom." 
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Getting 
Started 

This part of the manual contains information on those procedures 
you must follow before working through the Sample Session or 
using DeskMate on your own. Read and follow all instructions on 
these procedures: 

• Loading DeskMate and Choosing a Device 

• Copying your diskettes 
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Chapter 1 

Loading DeskMate 

To begin using DeskMate on your Color Computer: 

1. Connect any "optional" equipment you' re using, such as a disk drive, mouse, 
joystick, or printer, to the computer. If you don't know how to connect the various 
pieces, read the owner's manual you received with the equipment. (See Chapter 
18, "Telecom," for information on setting up necessary communications 
equipment.) 

2. Turn on the system. The screen should show: 

D I SK EXTEND ED CO LOR BA S IC 2. 1 

COPR 1982 , 1986 !lY TAN DY 
UNDER LICEN SE FROM MI CRO SO l-T 

AND M1CROWA RE SYSTE MS CORP. 

OK 

If you don't see a copyright notice, try pressing the reset button . If the 0 K message 
still doesn't appear, turn off your computer, and check that all your equipment 
is connected securely. Then, turn on the computer again. 

3. Place Diskette 1 in Drive 0, and close the drive door. If you are using two drives, 
you can place Diskette 2 in Drive 1. 

Type DOS c ENTER l. 

Note: If you do not have Disk Extended Basic, 2.1 or higher, see Appendix G . 

In a few seconds, you' ll see the 05-9 copyright message, followed by DeskMate's 
title screen, and then a date and time prompt. 

4. Type the current date within the mm/dd/yy format and press CENTER J (for example, 
12/20/87 ! ENTER l). 
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Ge.tting Started 

5. Type the current time within the HH:MM:SS AM or PM format and press (ENTER ) 
(for example, 12:30 PM (ENTER l). 

Note: You cannot enter military time for the current time. 

After y.ou enter the time, the Main Menu appears as shown below. 

Menu Bar 

Directory window 

bllD l;r:Jl'!mlJ ~ 

Progra•s II\ fo lder 3 I 

~ I : 
Ledger , 

Id!!• I 1 

ffit 
.-.--------------------------.... Traah 

Folder icons 

Note: Diskette 1 contains the operating system and the Ledger application . 
Diskette 2 contains Calendar, Text, Filer, Paint, and Telecom applications but 
no operating system . If you are us ing one disk drive and you want to use an 
application other than Ledger, you must replace Diskette 1 with Diskette 2 after 
you see the date and time prompt (after Step 3, above) and then choose Folder. 
3. If you are using two disk drives, you can see the applications on Diskette 
2 by choosing Folder 4. 

O n the Main Menu, the name of each application on the diskette is shown along with 
the icon (picture) that represents it. Notice at the top of the screen the Menu Bar that 
contains various DeskMate functions and on the right of the screen, the Folder icons. 

You ' ll learn more about the Main Menu of DeskMate later. Right now follow the 
instructions below and choose a device (keyboard or mouse/joystick) to move the cursor 
around on DeskMate's screens. 
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Loading DeskMate I 1 

Choosing the Device 

As you use DeskMate, you will move around on the screen by using either the keyboard 
or a mouse or joystick. To choose the device you want to use, follow the instructions 
below. 

Note: lf you are using a joystick, note that you must plug it into the right joystick 
port on your computer. (For detailed information on setting up and using your 
mouse or joystick, read the manual that accompanies it.) 

1. Press CAJ:I)C!) to select the Icon Bar. 
Cursor 

Control 

Display 

Icon 

l
r 

r 
The icons represent DeskMate's subfunctions, such as the printer and calculator. 

2. Use the arrow keys to move the highlight to the Cursor Control option, 
and press CENTER I. 

Cfio o::. e type of curso r 

control de11ice : 

Mouse o r Joy st: ck 
Keyboard only 

3. Use the arrow keys to move the "check" to the option you want, and press 
CENTER J. You return to the Icon Bar. 

4. Press I BREAK J to return to the Main Menu (or the application you were using). 
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Getting Started 

You can now use the method you chose throughout DeskMate. You can switch devices 
at any time while using DeskMate. Just follow the instructions above if you want to 
switch devices later on. · 

Next, follow the instructions in Chapter 2, "Copying Program Diskettes," to make 
copie.s of the DeskMate diskettes. 
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Chapter 2 

Copying Program Diskettes 

One of the most important things you should do before you use DeskMate is to make 
copies, or backups, of the DeskMate diskettes. Never use your original diskettes to run 
DeskMate. Do not modify the originals in any way. 

The instructions in this chapter are divided into two sections (for one- or two-drive 
users). Each section is divided into two parts (for keyboard or mouse/joystick users). 
Find the instructions that pertain to your system, and follow them twice-once to copy 
Diskette 1 and once to copy Diskette 2. 

Note: DeskMate Diskette 1 contains the format and backup functions, so be 
sure that you place Diskette 1 in the disk drive each time it is required in the 
instructions below. 

Using a One-Drive System 

If you are using a one-drive system, you must swap diskettes when making backups. 
The screen will prompt you during the copying process. 

Keyboard: 

1. Be sure that DeskMate Diskette 1 is in the disk drive. 

2. At DeskMate's Main Menu, press CAl:1XD to move the highlight to the Menu Bar, 
and use G to move the highlight to D 1 s I... . Press c ENTER J to select the Disk 
function. The Disk Menu appears. 

3. You must first initialize, or format, a diskette to hold the DeskMate programs. Be 
sure the highlight is on i ~ i t l J l i z e (use m or m to move the highlight) and 
press c ENTER l. 
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4. DeskMate asks which drive you want to use for the initialization . Be sure the 
highlight is on Drive 0 (use G or 8 to move the highlight) and press CENTER J. 

5. You are prompted to insert a diskette into Drive 0. Remove DeskMate Diskette 
1 from the drive, and replace it with a new, blank diskette (or an old diskette you 
"".ant to use again). Next, press CENTER ). 

When DeskMate is finished formatting your diskette, the screen displays: 

P.ep lac e Desk Mate disk . Press an y key t o co nti nue 

6. Replace the newly formatted diskette with DeskMate Diskette 1. Press any key. 

You return to the Main Menu. 

Now you can copy the original diskette to the newly formatted diskette. 

7. Press CAlJ:XD to reach the Menu Bar, and once again, choose Disk. 

8. Use QJ to position the highlight on b a c k up, and press c ENTER l. 

9. Since you are using one drive, choose the square marked 00 to l>0 (Drive 0 to 
Drive 0). Use G or G to move the marker. Press CENTER J. 

10. Insert the source diskette (the original Diskette 1 or 2, whichever you are copying) 
in Drive 0, and press CENIEB). 

11. You are then prompted to insert the destination diskette (the diskette you formatted 
and to which you want to copy). Remove the original diskette from Drive 0, and 
replace it with the newly formatted diskette. Press any key. 

12. The backup begins. You will be asked to alternately insert the destination diskette 
or the source diskette. Follow the instructions on the screen. 

13. When the backup is finished, you see Backup Complete. Be sure that Diskette 1 
is in the disk drive, and then press CENTER J to return to the Main Menu. 

14. Remove the original diskette and store it in a safe place. Remove the copy of Diskette 
1 and label it (with a felt-tipped pen) exactly as the original so that you always 
know which diskette you ' re using. 
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15. Insert the new copy of Diskette 1 in Dr.ive 0. 

Now you can proceed to the Sample Session. Use the copies you've made of the 
DeskMate program diskettes. 

Mouse/Joystick: 

1. Be sure that Diskette 1 is in the disk drive. 

2. At DeskMate's Main Menu, point to the Disk function on the Menu Bar, and click. 
The Disk Menu appears. 

3. You must first initialize, or format, a diskette to hold the DeskMate programs. Point 
to initialize, and click. 

4. DeskMate asks which drive you want to use for the initialization. Point to the option 
for Drive 0 and click. 

5. You are prompted to insert a diskette into Drive 0. Remove DeskMate Diskette 
1 from the drive, and replace it with a new, blank diskette (or an old diskette you 
wanttouseagain).Clickon ?rt:-:. !> u irr H to c c, r 1n u e . 

When DeskMate is finished formatting your diskette, the screen displays: 

Repl a c e De s k Mate dis~. Pre ;,s any k ey to co n tinue . 

6. Replace the newly formatted diskette with DeskMate Diskette 1. Click the 
mouse/joystick button. 

You return to the Main Menu. 

Now you can copy the original diskette to the newly formatted diskette. 

7. Point to the Menu Bar's Di 5 i<. option, and click. 

8. Point to b a c ~up on the Disk Menu, and click. 

9. Since you are using one drive, point to o e to o 0 (Drive 0 to Drive 0) and click. 

11 



Getting Started 

10. Insert the source diskette (the original Diskette 1 or 2, whichever you are copying) 
in Drive 0 and click on P r e ss ENTl::R to c on t i nu e 

11. You are then prompted to insert the destil11lfion diskette (the diskette you formatted 
and to which you want to copy. Remove the original diskette from Drive 0, and 

. replace it with the newly formatted diskette. Click the mouse/joystick button. 

12. The backup begins. You will be asked to alternately insert the destination diskette 
or the source diskette. Follow the instructions on the screen. 

13. When the backup is finished, you see Ba c k up Co mp l e t e. Be sure that Diskette 
1 is in the disk drive, and then click the mouse/joystick button to return to the 
Main Menu. 

14. Remove the original diskette and store it in a safe place. Remove the copy of Diskette 
1 and label it (with a felt-tipped pen) exactly as the original so that you always 
know which diskette you're using. 

15. Insert the new copy of Diskette 1 in Drive 0. 

Now you can proceed to the Sample Session. Use the copies you've made of the 
DeskMate program diskettes. 

Using a Two-Drive System 

Follow the instructions for keyboard or for mouse/joystick below to format and back 
up diskettes using two disk drives. 

Keyboard: 

1. Be sure that DeskMate Diskette 1 is in Drive 0. 

2. At DeskMate's Main Menu, press (gI)CD to move the highlight to the Menu 
Bar, and use G to move the highlight to 0 i s k. Press I ENTER) to select the 
D i s k function . The Disk Menu appears. 
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3. You must firs t inilialize, or format a diskette to hold the DeskMate programs. Be 
sure the highlight is on i ., i t i a l i z e (use CD or m to move the highlight), and 
press I ENTER J. 

4. DeskMate asks which drive you want to use for the initialization. Since you have 
two disk drives, use G or G to move the highlight to Drive 1, and press I ENTER J. 

5. You are prompted to insert a diskette in the drive you chose. Insert a new, blank 
diskette (or an old diskette you want to use again) in Drive 1, and press I ENTER l. 

When DeskMate is finished formatting your diskette, the screen displays: 

Rep lace Desk Mate disk. Pre s s an y key t o co nt inue 

6. Since you used Drive 1 for the initialization, you don' t have to swap diskettes. 
Press any key to return to the Main Menu. 

Now you can copy the original diskette to the newly formatted diskette. 

7. Press CAJ:IX[) to reach the Menu Bar, and once again, choose Di s k . 

8. Use ffi to position the highlight on bac ku p, and press I ENTER I. 

9. Since you are using a two-drive system, choose the square marked D 0 t o D 1 (Drive 
0 to Drive 1). Use G or G to move the marker. Press CENTER ). 

10. Be sure that the source diskette (the original Diskette 1 or 2, whichever you are 
copying) is in Drive 0. A formatted diskette should already be in Drive 1. Press 
CENTER !. 

11. When the backup is finished, you see Backu p Complete. 

12. Be sure that Diskette 1 is in Drive 0, and then press I ENTER I to return to the Main 
Menu. 

13. Remove the original diskette and store it in a safe place. Remove the copy of Diskette 
1 and label it (with a felt-tipped pen) exactly as the original so that you always 
know which diskette you're using. 
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14. Insert the copy of Diskette 1 in Drive 0. 

Now you can proceed to the Sample Session. Use the copies you've made·of the 
DeskMate program diskettes. 

Mouse/Joystick 

1. Be sure that Diskette 1 is in Drive 0 . 

2. At DeskMate's Main Menu, point to the " L function on the Menu Bar, and dick. 
The Disk Menu appears. 

3. You must first initialize or format, a diskette to hold the DeskMate programs. Point 
to , and click. 

4. DeskMate asks which drive you want to use for the initialization. Since you are 
using a two-drive system, point to Drive 1, and click. 

5. You are prompted to insert a diskette in the drive you chose. Insert a new, blank 
diskette (or an old diskette you want to use again) in Drive 1. Point to r, ., , 
.r.rr 1..r r.~l , andclick. 

When DeskMate is finished formatting your diskette, the screen displays: 

, f:': \. ! .;J "'' Jt ~ · ,, • ~· C'1' CJr1; • cy .. u t:n~ inue 

6. Since you used Drive 1 for the initialization, you don' t have to swap diskettes. 
Just click the mouse/joystick button. 

You return to the Main Menu. 

Now you can copy the original diskette to the newly formatted diskette. 

7. Point to .• on the Menu Bar and click. 

8. Point to , " . on the Disk Menu and click. 

9. Since you are using a two-drive system, point to D n : o o 1 (Drive 0 to Drive 1) 
and click. 
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10. Insert the diskette you want to copy in Drive 0. A formatted diskette (the destination 
diskette) should already be in Drive 1. Click the button on the mouse/joy~tick. 

11. When the backup is finished, you see cL~ c ~up c om p l e t e . 

12. Be sure that Diskette 1 is in Drive 0, and then click the mouse/joystick button to 
return to the Main Menu. 

13. Remove the original diskette and store it in a safe place. Remove the copy of Diskette 
1 and label it (with a felt-tipped pen) exactly as the original so that you always 
know which diskette you're using. 

14. Insert the copy of Diskette 1 in Drive 0. 

Now you can proceed to the Sample Session. Use the copies you've made of the 
DeskMate program diskettes. 

Formatting and Backing Up Data Diskettes 

As you use DeskMate applications for your own needs, you may want to store 
information on a /1 data diskette. /1 A data diskette can contain more information than 
a program diskette because there are no DeskMate applications to take up valuable 
file space. You won ' t need a data diskette for the Sample Session, but later on you 
can refer to the following instructions to create a data diskette to hold DeskMate 
application files . 

When you made a backup of the DeskMate program diskettes, you first had to initialiu 
the diskette so that it could hold the information. When you initialize a diskette, you 
don' t necessarily have to use it for a backup. You can store information on a diskette 
that you use for data only. This /1 data diskette" need only be initialized to prepare 
it for use. 

First, initialize a diskette to hold data files by following instructions 1 - 6 in this chapter 
for a one- or two-drive system (using a keyboard or a mouse/joystick). 
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Follow the instructions below (for your system) to store a file on the formatted diskette. 

One-Drive System: 

1. Before you exit the application you are using, choose ~ il v £' from the File Menu 
on the Menu Bar. 

The message, ::. a " e a s : __ . appears. 

2. Remove the program diskette from Drive 0 and insert the formatted data diskette. 

3. Type the name of the file you want to save (using up to eight characters) and press 
CENTER !. 

Your file is saved on the data diskette and you return to the application you were 
using. 

4. Remove the data diskette and insert the program diskette you were using. 

5. Choose l lo~ e from the File Menu. 

The message, s A v E ' y e s .,. no , appears. 

6. Since you already saved the file to your data diskette, move the marker to no and 
press CENTER) or click the button on your mouse/joystick. 

You return to DeskMate's Main Menu. 

Two-Drive System: 

1. Before you exit the application you are using, choose save from the File Menu 
on the Menu Bar. 

2. Insert a formatted data diskette into Drive 0. 
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3. Type the number of the data device you are using, followed by a colon. Then, 
type the name of the file you want to save (using up to eight charactei:s). For 
example: 

l:Budget (To save the file named Budget to the diskette in Data Folder 1.) 

Thenr press (ENTER l. 

You return to the application you were using. 

4. Choose close from the File Menu. 

The message, SA I/ E' >'cs ,, n c , appears. 

5. Since you already saved the file to a data diskette, move the marker to no and 
press (ENTER J or click the button on the mouse/joystick. 

You return to DeskMate's Main Menu. 
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Sample 
Session 

This part of the manual is designed to help you become more familiar 
with DeskMate and let you have a little fun, too! You can start at 
the beginning of the examples and work your way through each 
one, or choose a particular application that you want help with. 
While working through the examples, you might want to add more 
sample data or try other features of the application that aren' t 
covered in this part. To use an application to its full capability, 
consult the Reference part of this manual. 

You can work through the entire Sample Session by just following 
the instructions in each Chapter, but you may first want to read 
" Moving Around" in the Reference section to become more familiar 
with keyboard and mouse/joystick techniques. You can also refer 
to the Quick Reference card if you need occasional help. 





Chapter 3 

[i:J Beginning the Sample Session 

Before you start the Sample Session, read and follow the instructions in Chapters 1 
and 2. 

Cl 
L:J Choosing Screen Colors 

You can use the Display utility to change screen resolution (40- or 80-column format) 
in the Telecom, Text, and Ledger applications and to alter the available colors on the 
screen of the application you are using. 

Later in the Sample Session, you w ill change the resolution of the screen in the Text 
application to an 80-column format . For now, follow the instructions below to change 
background and foreground colors. You can restore the original screen colors at any 
time. U you are using a mouse/joystick, point to the top bar of the screen (the name 
of the application) and dick. If you are using the keyboard, press ~. 

At the DeskMate Main Menu, select the Icon Bar (•). 

Keyboard: Press CAl:DG) to choose the Icon Bar. 

Mouse/Joystick: Point to • and dick. 

Folder 
Cursor 

Control 
Icon 
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Select the Display utility from the Icon Bar. 

Keyboard: Use the right arrow key to move the highlight to the Display icon and 
press CENTEID. 

Mouse/Joystick: Point to the display icon and click. 

Window Bars Mode indicator 

lJnnE NU node · nad1fLj i:olor-

Foreground Background 

~ lDJ • • [> 

Command Bar 
~ (I(; n• I.Ill ·. re 

I 1 I I • (' • 
'. . • • • P. c. ~ 

Color Palette 

• •• • Pres'> C ' ll l£P.J t.o ~ont:1nup 
Pr,. .. s l RCRt.:J to cane-. Pl 

R,G,B Color Scales 

Note: See this screen on the back cover of the manual for a true 
rep resentation of colors. 

Select the bc1ckground color ( h u) from the Color Palette. 

Keyboard: The highlight is .1lready positioned on the background color, so go to 
the next step. 

Mouse/Joystick: Point to B c. and click. 

Move to the Red, Green, and Blue Color Scales. 

Keyboard: Press the space bar. 

Mouse/Joystick: Point to •. , G, or is on the Color Scales and click. 

Notice that when you move to the Color Scales the mode indicator on the Display 
screen changes to nod i f y Co ~o r to let you know that you can now change the 
intensity of the color you selected from the Color Palette. 
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[_
1 Set the Color Scales to alter the background color. 

Keyboard: Use G and 8 to move among the red, green, and blue Color Scales. 
Use Q) and CD to move to a higher or lower level of color. 

Mouse/Joystick: Click on R,G, or B, and then click on the desired color level. 

Notice that the screen's background color changes as you maneuver the Color 
Scales. 

Select the Color Palette again to alter the foreground (F G) color. 

Keyboard: Press the space bar and then use 8 to move to F G. 

Mouse/Joystick: Point to F G and click. 

Notice that the mode indicator changes again to Se l e c t Pa l e t t e to let you know 
that you can now select a color from the Color Palette . 

• ., Move to the Red, Green, and Blue Color Scales. 

Keyboard: Press the space bar. 

Mouse/Joystick: Point to R, G, or B on the Color Scales and click. 

Set the Color Scales to alter the foreground color. 

Keyboard: Use G and 8 to move among the red, green, and blue Color Scales. 
Use Q) and CD to move to a higher or lower level of color. 

Mouse/Joystick: Click on R, G, or B, and then click on the desired color level. 

Notice that the screen's foreground color changes as you maneuver the Color Scales. 

L Exit the Display utility. 

Keyboard: Press (ElilOEBJ to save the changes (or I BREAK l if you do not want to 
save the changes) and return to the Icon Bar, then press ! BREAK l to return to the 
Main Menu. 
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Mouse/Joystick: Click on P r<?:; s t N l E q t o r: on t 1 ri L. "' to save the changes and 
return to the Icon BJr (or click on Pr _, J £\'lf AK to c ..inc e I if you do not want 
to save the changes), then point to • and click to return to the Main Men·u . 

Note: The application that you choose will now reflect the new foreground 
and background colors that you chose in the Display Utility. 

Calculator works in the same way as a hand-held calculator. Follow the instructions 
below to perform some mathematical calculations such as adding, subtracting, and 
multiplying and to see how you can us~ the " memory" feature to store and recall 
calculations. 

24 

At the DeskMate Main Menu, select the Icon Bar ( • ). 

Keyboard: Press cmxf) to choose the Icon Bar. 

Mouse/Joystick: Point to • and click. 

Select the calculator function from the Icon Bar. 

Keyboard: Use the right arrow key to move the highlight to the calculator function 
and press CENTER l. 

Mouse/Joystick: Point to the calculator function and click. 

The name of the application ( D MM E fJ u, for DeskMate Main Menu) is shown in the 
upper left corner of the Calculator screen. 
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Add the following figures and place them in memory. 

12.93, 38.70 

Keyboard: Type 12.93 M+ 
Type 38.70 M+ 

Mouse/Joystick: Point and click to each digit in the first number you're adding. 
Then point to M • and click to enter the figures into memory. Enter the other figure 
in the same manner. 

Note: If you make a mistake while entering figures, type MC to clear the 
memory and re-enter the figures. 

Select MR to see the accumulated total of the figures you entered. 

Keyboard: Type MR 

Mouse/Joystick: Point to MR and click. 

The total should be 51.63. 

Subtract 50.00 from the total you have in memory. 

Keyboard: Type 50.00 M -

Mouse/Joystick: Point to the numbers and click, and then point to M - and click. 

Select MR 

The amount in memory should be 1.63. 

Multiply 6 by 9. 

Keyboard: Type 6 x 9 = (You can also press CENIE1D for "equals .") 

Mouse/joystick: Point and click to the numbers and operators . 

The answer (54) nppears in the calculator window. 
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Now check to see if the previous total that you e ntered into memory (1 .63) is still 
there. 

Keyboard: Type MR 

Mouse/Joystick: Point to M h and click. 

Clear the amount from memory. 

Keyboard : Type MC 

Mouse/Joystick : Point to MC Jnd click. 

The amount (1 .63) is now erased from memory. 1.63 still appears in the calculator 
window. 

Exit the Calculator function. 

Keyboard: Press~:. 

Mouse/Joystick: Point to Qi. r.. and click. 

You return to DeskMate's Icon Bnr. 

Press JffitAK) or point to * and click to return to the ~1ain Menu. 

~ 
L::::J Setting the Time 

You can use the Time function on the Icon Bar to reset the system date and time. 

At the DeskMate Main Menu, select the Icon Bar ( • ). 

Keyboard : Press .. -AJ:JJ0 to select the Icon Bar. 
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Mouse/Joystick: Point to • and click. 

Select the Time function from the Icon Bar. 

Keyboard: Use 5 to move to the Time function and press CEJifi't1D. 

Mouse/Joystick: Point to the Time function and click . 

car ... , ,, : 
T ·me i:.: 

P r e !. ; r .._ '-. T - R J ~ i..; 1... "> l ~ ; 

Prf:S5 tB•-A KJ ., 1. r.t 'l 

Type 08/07/86 crnT"Elf) for August 7, 1986. 

You can enter the correct time (using up to 12 characters), or press (ENTER) to 
bypass the time. 

You return to DeskMate's Icon Bar. The systl'm date and time are now set to the 
entries you made above. Any files you create now will show these settings when 
you view their statuses. When you enter the Calendar application, August 7, 1986, 
will be highlighted . 

Press (BREAK) or select O to return to the Main Menu. 

The Icon Bar's Folder and Printer fu nctions are explained in detail in Chapter 12 of 
the Reference part. Fur now, continue lo work through the Sample Session. 
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Chapter 4 

Setting Up a Schedule 

You can use Calendar to remind you of business appointments, lunches, meetings, 
or anything else you may need to remember on a daily basis. You can also set up the 
calendar to remind you of personal occasions, such as birthdays, anniversaries, car 
tune-ups, and house maintenance duties. The more you consult Calendar, the more 
uses you will find for it. Just keep in mind that virtually anything you might want 
to remember can be easily recorded in DeskMate's Calendar! 

Choosing Calendar 

The Calendar application is contained on the Main Menu of DeskMate Diskette 2. If 
you are using one disk drive, you must remove DeskMate Diskette 1 and replace it 
with DeskMate Diskette 2. Then follow the instructions below to select Calendar. 

~ Select the correct Program Folder. (Folder 3 for a one-drive system; Folder 4 for 
a two-drive system.) 

Keyboard: Press CArnB to move to the Folder Icons, and use m or CD to 
position the highlight on the correct Program Folder. Press I ENTER I. 

Mouse/Joystick: Point to the correct Program Folder and click. 

The applications contained on DeskMate Diskette 2 (Calendar, Text, Filer, Paint, 
and Telecom) appear on DeskMate's Main Menu, and you return to the Program 
Directory. 

Select s wap from the Disk Menu, and then select Calendar from the Main Menu. 

Keyboard: Be sure the highlight is on the Calendar icon, and press I ENTER I. (Use 
the arrow keys to position the highlight on Calendar.) 

Mouse/Joystick: Point to the Calendar icon and click twice. 
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Menu Bar 

Calendar 

Current day and date 

Text area 

From the Menu Bar, you can access the Calendar functions, a help window, scrolling 
arrows, and the Icon Bar. The Calendar area shows each day of the month (with the 
current day and date shown in the lower left area of the screen). The text area is like 
a notepad on a desk calendar. You can jot down your entire schedule for the selected 
day. 

Entering the Schedule 

If you entered the system date given at the beginning of the Sample Session, the screen 
shows August 7, 1986. 

30 

Move the highlight to another day on the calendar. 

Keyboard: Use the arrow keys to move the highlight around on the screen. 

Mouse/Joystick: Point to any day on the calendar and click. 

Move to the Calendar Menu Bar and select Tex t. 

Keyboard : Press CA.UJCD to move to the Menu Bar. Use G to position the 
highlight on Te ~ t , and then press CENI:EID. 

Mouse/Joystick: Point to T ex t on the Menu Bar and click. 
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_ Select ed it from the Text Menu. 

Keyboard: Use the arrow keys to move the highlight to ed i t and press I ENTl:RJ. 

Mouse/Joystick: Point to e di t and click. 

After you select the edit function, a Command Bar (with an exit function, help window, 
and up and down scrolling arrows) appears above the text area. You can begin entering 
text at the cursor within the text area. 

Note: When you first enter the edit function, you are in overstrike mode, 
indicated by the flashing cursor block. When you are in insert mode, the cursor 
is a vertical line between two characters. Press CAIIXD to switch between the 
overstrike and insert modes. Press crn:DCID to switch between typing in all 
upper- or lowercase. To delete characters, you must be in the insert mode and 
then use CAI:DG. 

Type: 

9:30 AM Project meeting I ENTER : 
!ENTER ) 
12:30 PM Lunch c ENTER l 
!ENTER ) 
5:30 PM Cleaners ! ENTER ) 
!ENTER ) 
8:00 PM Dinner Pa.rty I ENTER l 
! ENTER ) 

As you type in the last entry, the screen scrolls up one line so you can see the line 
on which you ' re typing. You can scroll back up by using the OJ on the keyboard or 
the O on the Text Command Bar (if you are using a mouse/joystick). 

Exit the edit function and return to the calendar area. 

Keyboard: Press I BREAK J. 

Mouse/Joystick: Point to exit on the Text Command Bar and click. 

Use the methods described above to select another day from the calendar area for 
entering a schedule. 
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Return to the text area and type the following: 

8:00 AM Breakfast meeting (ENTER l 
!ENTER l 
12:45 PM Lunch (ENTER l 
!ENTEA l 
6:30 PM Soccer game (ENTER J 

Return to the calendar area. 

Finding an Entry 

Select Text from the Menu Bar. 

Select f i n d from the Text Menu. 

Type Meeting (ENTER l. 

The first date containing the word " meeting" is highlighted and the text of that 
date is displayed. 

Now, press CArnCD! ENTER l to see the next "meeting" on your schedule. 

CArnCD is the "shortcut" method of selecting the find function . (Note that "7'' 
appears next to find on the Text Menu.) Pressing ! ENTER l accepts " Meeting" as 
the word you want to find again. 

Printing the Schedule 

Select Fi le from the Menu Bar. 

Select pr i n t from the File Menu. 

P r int P.l day 0 week 
u mont h [~ al t 
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To move the "check" to month, use the arrow keys on the keyboard and press 
c ENTER l, or use the mouse/joystick to point and click. 

When the printer is finished, you return to the main Calendar screen . You now have 
a sample printout of schedules that you created. 

Exiting Calendar 

-, Press (BREAK l to exit the Calendar application. 

sa ve ' -,,,- yes no 

Since this was only a practice session, you don' t need to save the schedules you 
created. 

Move the check to no, and press CENTER J or click. 

Keyboard: Use G and G to switch between yes and no. 

Mouse/Joystick: Point to no (the marker automatically follows the pointer) and 
then click. 

You return to the Main Menu. 
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I I Writing a Letter 

Think of the Text Editor application as a blank sheet of paper in a typewriter-ready 
for you to fill with words of poetry, correspondence to friends or businesses, or those 
hard-to-find grocery lists. You can even send pages of text using DeskMate's Telecom 
application. In this example, you will write a letter and then print it. We suggest that 
you type the text offered in this chapter so that you can use the editing techniques 
presented. Later, you can experiment with your own text. 

Note: When you first enter the T t:!Xt application, you are in overstrike mode, 
indicated by the flashing cursor btock. When you are in insert mode, the cursor 
is a vertical line between two characters. Press CA(I)Cl) to switch between the 
overstrike and insert modes. Press CCJJ:UJ(]) to switch between typing in all 
upper- or lowercase. 

Composing the Letter 

Select Text Editor from the Main Menu. 

Keyboard: Use the arrow keys to position the highlight on the Text Editor icon 
and press (ENTER ;. 

Mouse/Joystick: Point to the Text Editor icon and click. 

Use the main portion of the screen like a blank sheet of paper. The Menu Bar contains 
access to the Text Editor functions, a help window, scrolling arrows, and the Icon Bar. 

Type the following letter on the screen. 

Note: When you reach the end of a line, Text Editor automatically moves the 
entire word (or string of text) to the next line. 
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January 1 , 198 7 (ENTER l 
(ENTER ) 
Dear Pat, (ENTER ) 
!ENTER J 
You ' l l neve r believe it , but I' m wr i ting this to you o n the new 
Tandy Colo r Comput e r 3 I got f or Christmas . It's really a break 
from th.e robe s a nd perfume tha t I u s ually get, and I'm ha vi ng 
l o t s of fun w i t h i t ' (ENTER J 

!ENTER J 

I can d o so muc h wit h th is Desk Mate program. I'm using the Text 
Ed i tor now , but I can also keep files, create a budget, jot 
rf:!mind e rs to mysel f in Calendar, and even paint! I could send 
ttns letter t o you within second s o f writing it i f you had a 
com pu te r ( with mo d e m) t oo . (ENTER ) 
!ENTER J 

Stop typing the letter for a minute and follow the instructions below to edit a portion 
of your letter. 

_ First (in overstrike mode), move the cursor to the word with on the last line of 
the letter. 
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Keyboard: Use the arrow keys to move the highlight to the win with. 

Mouse/Joystick: Point to the w in with, and click. 

Type and. 

Move the cursor one space to the right of the letter h, and press CArn8 (for 
backspace) to delete h . 

To close the extra space between a nd and mode m, move the cursor to them in 
modem, press CAI:lXD (to begin using insert mode), and then press CALIB again 
to delete the space. 

Press CACIJ(IJ to return to overstrike mode. 



Writing a Letter I 5 

__ Now, continue typing the letter. 

Why don 't you talk to Joh n a bou t g e tti n g a Tandy Col or Computer 
3 . He c a n u s e i t t oo - tor the ne w bu s iness ' (ENTER l 
CENTER ) 
J ust th i nk ' No mo re s t amps or letters lo s t in th e mail. And 
i t ' s chea pe r th a n a t e le phone c a l l ! CENTER J 
(ENTER ) 
I' m going to cl o s e fo r n o w and try some mor e pr o grams . Write 
s oo n. CENTER ) 
CENTER) 
Yo ur f r ien d, CENTER ) 
CENTER ) 
CENTER ) 
Da n ielle CENTER ) 

You can scroll through the letter by using the arrow keys on the keyboard or the Menu 
Bar arrow keys with the mouse/joystick. 

Editing the Letter 

If you made a mistake while typing the letter, you can use CArnG (backspace) to 
delete letters as you saw in the above example. You can also edit by moving, inserting, 
or deleting blocks of text. Follow the instructions below to reverse the order of two 
paragraphs in the letter you just typed . 

C Move the cursor to the first character in the paragraph that begins, Just think . . . 

C Highlight the entire paragraph. 

Keyboard: Press CA1:1XD to move to the Menu Bar, and then use G to move 
the highlight to Bl ock. Press c ENTER J. Use the arrow keys to highlight the 
paragraph. Press c ENTER l. 

Mouse/Joystick: Hold down the button on the mouse/joystick for about two 
seconds, then drag the highlight until it covers the paragraph. (There is a slight 
delay before the text is highlighted.) 
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Move to the Menu Bar and select 9 l '-' c k . 

Select c opy from the Block Menu. 

The block of text remains on the screen but it is also stored in a copy buffer (a 
reserved portion of memory) and can b1! placed in any area of the text that you 
choose. -

Now move the cursor to the end of the second paragraph. (The line cursor should 
be to the right of the word "too.") 

Move to the Menu Bar and select B Lo.:: k again. 

Select i rs er t from the Block Menu. 

The text you copied now appears in two places in the Jetter. 

Move the cursor to the second occurrence of the paragraph that begins, Just 
think . . . 

Move to the Menu Bar and reselect B I o ' k . 

Choose s ~ l e c t from the Block Menu. 

Highlight the entire paragraph. 

Move to the Menu Bar again and choose B l o c k . 

Select d e l e t e from the Block Menu. 

The text that was highlighted disappears. The paragraphs appear in their new order, 
and you are ready to print the Jetter . 
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Using the SO-Column Format 

Follow the instructions below to display thE· letter you just wrote in an 80-<:olumn format. 

Select the Icon Bar. 

Keyboard: Press CA!::.i)(!). 

Mouse/Joystick: Point to .. and click. 

Select the Display utility from the Icon Bar. 

Keyboard: Use the right arrow key to move the highlight to Display and press 
t ENTER l. 

Mouse/Joystick: Point to Display and click. 

Select the 80-column format. 

Keyboard: Use the right arrow key to move the marker to the 80-column box. 

Mouse/Joystick: Point to the 80-column box. 

Return to the Icon Bar. 

Keyboard: Press CENTER J. 

Mouse/Joystick: Point to Pre ss ·EN_TER_, t o c o ntinue and click. 

Return to the Text application. 

Keyboard: Press I BREAK l. 

Mouse/Joystick: Point to " and click. 

The letter you wrote now appears on the screen in the new format. Notice that Text 
Editor automatically readjusts the text to fit the new format. 

Repeat the instructions above to return to the 40-column format . 
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Printing the Letter 

If you have a printer and want a copy of the letter you just created, follow the 
instructions below. 

Move to the Menu Bar and select F i t e. 

Select or i n t from the File Menu. 

Keyboard: Use the arrow keys to move the highlight to pr i n t . Press (ENTER l. 

Mouse/Joystick: Point to pr i n t and click. 

After your printout is completed, the letter reappears on the screen. 

Exiting Text Editor 

When you are ready to exit the Text Editor application, follow the instructions below: 
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Move to the Menu Bar and select F i l e . 

Select , , c· st: from the File Menu. 

no 

To save your letter in a text file, choose y e s by pressing ! ENTER J or clicking. 

When prompted to name the file, type LEITER ! ENTER J. You return to DeskMate's 
Main Menu. 



Chapter 6 

EJ Creating a 1'tf ailing List 

The exercise below will help you bE:come more familiar with the Filer application. You'll 
learn how to set up a mailing list-from developing your own format to adding and 
deleting names on the list. Use Filer as you would use ordinary 3 x 5 cards, tucked 
away in appropriately labeled boxes. The wonderful difference is that with DeskMate, 
you won't ever have to look for a lost box or take up precious room in your closet 
or office with box upon box of filing cards. Also, each time you add a new card, 
DeskMate automatically alphabetizes all the cards. 

Laying Out a Format 

Choose Filer from the Main Menu. 

Keyboard: Use the arrow keys to move the highlight to the Filer icon, and press 
CENTEA J. 

Mouse/Joystick: Point to the Filer icon and click. 

File name window 

Blank cards 
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This screen shows blank cards and prompts you to enter a filename. You must enter 
a filename and create a card format for the new file before you can use the Filer 
functions. · 

Name the file that will contain the cards you create. Type MUST I ENTER J. 

Now you are ready to create a format for the mailing list. A format is the way you 
want the card to look on the screen. 

Type: 

Last Name I ENTER I 
I ENTER I 
First Name I ENTER I 
CENTER ) 
Street r-..1 E....,N"""t....,EB ..... I 

!ENTER J 
City c~E~N-T-ER~J 
CENTER ) 
State C ..... E .... N ...... T_,ER ..... l 
CENTER I 
Zip Code CENTER l 
I ENTER I 
Phone !'""'E...,N,...T""'ER....,l 
CENTER ) 

Enter the edit characters for the phone numbt>r by following the instructions below. 

Use the up arrow to move back to the phone number line. 

Press CSHIEIB. 

Type ( and then press the right arrow key three times. 

Type ) and press the right arrow key three times. 

Type - ! ENTER I. 
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Select For 11 at from the Menu Bar. 

Keyboard: Press CArnCD to move to the Menu Bar. The Format Menu is 
automatically displayed. 

Mouse/Joystick: Point to Format anc. click. 

Choose ex ' t from the Format Menu. 

Keyboard: Use OJ to move the highlight to ex i t and press I ENTER J. 

Mouse/Joystick: Point to ex i t and click. 

You return to the main screen for Filer. The filename (ML I S T) now appears at the 
bottom of the screen. Follow the instructions below to add data to the mailing list. 

Creating or Adding Cards 

Move to the Menu Bar and select C r. r o . 

Keyboard: Press CAI:IJrn to move to the Menu Bar and then use G to move to 
Cara . Press CENTER ). 

Mouse/Joystick: Point to ca '1 and click. 

The Card Menu is for viewing cards, inserting new cards, printing the information 
on the cards, deleting cards that you no longer need, and changing the format. You'll 
notice that some of the selections appear only as a "shadow." This means that the 
function is unavailable at this time. After you add data, these functions will appear 
as the others. 

Select i n s e r t from the Card Menu to add information to the mailing list. 

Keyboard: Use OJ to move the highlight to i n s er t and then press I ENTER l. 

Mouse/Joystick: Point to i n s e r t on the Card Menu and click. 
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Type the following names and addresses in the format you jus t created: 

Johnson CENJ"ER) 
Ray IENTER l 
4000 Main Street I ENTER i 
Ft. Worth I ENTER 1 
Texas I ENTER l 
76107 I ENTER l 
8175558791 

Note that you do not need to include the parentheses and hyphen in the phone number 
because they are part of your format. The cursor wiJI skip by them o n the screen . 
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Move to the Menu Bar and choose the add function from the Insert Menu. 

Keyboard: Press CAa:XD to move to the Menu Bar. The highlight should already 
be on add, so just press I ENTER). 

Mouse/Joystick: Point to I ns er t on the Menu Bar and click, and then point to 
ei d d and click. 

The data you just entered is recorded on your disk, and you have a blank card 
so that you can add another name to the list. 



Type: 

Dominique (ENTER 1 
Jacqueline (ENTER l 
634 Trinity Avenue (~E~N~T-ER~l 
Ft. Worth c ENTER l 
Texas (ENTER 1 
76018 CENTER ) 
8175554591 

Creating a Mailing List I 6 

Choose add again to add the name you just typed to the mailing list. 

Keyboard: This time, use the shortcut method and press CAl:JX:!) to add the name 
to your mailing list. 

Mouse/Joystick: Point to I n s er t on the Menu Bar and click. Point to add on 
the Insert Menu and click. 

Type: 

Petta (ENTER J 
Linen t ENTER 1 
6501 Blackwood t ENTER l 
Ft. Worth c ENTER 1 
Texas c ENTER 1 
73092 c ENTER 1 
8175553249 

Choose exit to record the name you just typed and return to the Filer main screen. 

Keyboard: Press CBREAK J to exit this screen. 

Mouse/Joystick: Point to I n s e rt on the Menu Bar and click, then point to c x i t 

on the Insert Menu and click. 

The main screen for Filer now shows the names you entered, filed in alphabetical order 
by last name. 
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Editing Data 

Periodically, you'll need to update information on your cards. The exercise below shows 
you how. 
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Highlight the name, R a y J oh n s on, from the index cards. 

Keyboard: Use the arrow keys to highlight the name, Ra y Joh n s c r . 

Mouse/Joystick: Point to Ray J o hnso,, and click. 

Select card from the Menu Bar. 

Keyboard: Press CAaXJ] to go to the Menu Bar, then use G to move the 
highlight to Ca .. d and press c ENTER I. 

Mouse/Joystick: Point to car d on the Menu Bar and click. 

Select v, e w from the Card Menu. 

Keyboard: Make sure the highlight is on v i P w and press (ENTER I. 

Mouse/Joystick: Point to v i e w on the Card Menu and dick. 

Move to the street line and type: 

300 Taylor Street (ENTER l 

Keyboard: Use CD to move the highlight to the street line. 

Mouse/Joystick: Point to the street line and click. 

Move to the Menu Bar and select F • t f'. 

Keyboard: Press CAaxD and then press CENTER). 

Mouse/Joystick: Point to F i l c and click. 



Creating a Mailing List I 6 

Select ex i t from the File Menu. 

Keyboard: The highlight should already be on ex i t, so just press CE"NT[R). 

Mouse/Joystick: Point to e x i t and click. 

The record is automatically updated, and you return to the main screen of Filer. 

Deleting a Card 

Follow the instructions below and delete a card. The procedure is the same for keyboard 
or mouse/joystick. 

Highlight the name, Ray J ohnson, from the index cards. 

Select Card from the Menu Bar. 

Select delete from the Card Menu. 

Notice that the card for Ray Johnson has been deleted from the file. 

Closing the File 

Follow the instructions below to close the file . The procedure is the same for keyboard 
or mouse/joystick. 

Select F i le from the Menu Bar. 

Select c los e from the File Menu. 

The mailing list you just created is now stored on disk by the Filer program under 
the file name of ML Is T, and the DeskMate Main Menu appears. 
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Searching for Data 

Follow the instructions below to find specific information in an index card file named 
Sample on your diskette. 

Select Folder 1 from DeskMate's Main Menu. 

Keyboard: Press CAJ:I)8 to move to the folder icons. Then press CD twice {or 
three times if you are in Folder 4) to move to Folder 1. Finally, press c ENTER l. 

Mouse/Joystick: Point and click on Folder 1. 

Choosing a data folder lets you see all of the data files created by DeskMate applications. 
Folder 1 now contains two index card files { ~ L r ST and s amp l e ), and a text file 
( L t t er ). 
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Open the file named s " .n::. t t: • 

Keyboard: Use the arrow keys to move the highlight to the data file, S ., m ri I e, 
and then press c ENTER I. 

Mouse/Joystick: Point to the Sample data file and double click (click twice). 

Note: When you open a data file, the application is automatically opened. 

The Filer main screen is now displayed showing the cards in the Sample file. 

Select \ 1 e w from the Card Menu. 

Move to the Menu Bar and select F i t e . 

Select • • " · from the File Menu. 

Set up a search for all birthdays in the month of May. 

Press c ENTER I twice to get to the date field . At the date field, type May*. 

Move to the Menu Bar and select r ' n d . 



Creating a Mailing List I 6 

Select 1 , no from the Find Menu. 

You return to the view screen and the first card that contains the word " May" 
in the date field . 

Use (SH I FT JG from the kl:yboard, or click on the right scrolling arrow with the 
mouse/joystick to see the next card that contains a May birthday. 

Select -= x i t from the File Menu, or press ! BREAK J to exit the view screen. 

The Filer main screen appears. 

Select c t ') ~ e from the File Menu, or press ! BREAK J to close the Filer and return 
to DeskMate's Main Menu. 
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Chapter 7 

Becoming an. A~ist 

This chapter shows how you can really be creative with DeskMate's Paint application . 
The possibilities for Paint are too numerous to show here, but you can let your 
imagination soar and find other ways to use Paint to its full capabilities! 

Drawing a Picture 

Select Paint from DeskMate's Main Menu. 

Keyboard: Use the arrow keys to position the highlight on the Paint icon, and 
press I ENTER l. 

Mouse/Joystick: Point to the Paint icon and double click. 

This is Paint's main screen. The blank area of the screen acts as a canvas. The Menu 
Bar contains access to Paint's functions, a help window, and the Icon Bar. The " pencil" 
is used to draw on the screen. You'll see other methods later (such as brushes and 
a "spray can") from which you can choose to draw on the screen. 

Paint actually works better if you have a mouse or joystick, but you can also use the 
arrow keys on the keyboard. If you chose, at the Main Menu, to use the keyboard 
as your device and now want to change to a mouse or joystick, you must perform 
a preliminary step. 

Move to the Menu Bar and select Ed i t . 

Keyboard: Press aJ:l)(D and then use G to move to Ed i t and press I ENTER l. 

Mouse/Joystick: Point to Ed i t on the Menu Bar and click. 
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Select d c / i c e from the Edit Menu. 

Keyboard: Use ffi to move the highlight to d c v i c P , and press c ENTER l. 

Mouse/Joystick: Point to tl c i . c> on the Edit Menu and click. 

The options are: 

k e )' o o a 1· d on L t 
jo ;s 1ct_ 

mouse or J O> Stick 

Use m and m to position the highlight on the device you want to use, and press 
CENTER ). 

Note: The Paint application does not recognize the mouse or joystick if you 
have chosen keyboard as your device. 

The screens may show slight differences according to the method you choose. 

Use the pencil to draw on the screen. 

Keyboard: Press the space bar once and use the arrow keys to move the pencil 
around on the screen. Press the space bar whenever you want to start or stop 
drawing. 

Mouse/Joystick: Hold down the button on the mouse/joystick and move the pencil 
around on the screen creating various shapes and designs. Release the button to 
stop drawing. 

Experiment awhile using the pencil to draw, and then clear the screen as instructed 
below. 
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Move to the Menu Bar and select ~ J i t . 

Keyboard: Press CA1:IXD to move to the Menu Bar, use 8 to move the highlight 
to Edit , and then press CENTER J. 

Mouse/Joystick: Point to r cl i t on the Menu Bar and click. 
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[_ Select clear from the Edit Menu. 

Keyboard: Use G) to move the highlight to c l ear and press c ENTER J. 

Mouse/Joystick: Point to c l ea · on the Edit Menu and click. 

The message, s e l e c t a b a c kg r o u n cJ c o l o r, appears along with 16 colors from 
which to choose a background color. 

[. Select a new color for the screen's background, or keep the current color. 

Keyboard: Use the arrow keys to move the highlight to another background color 
and press CENTER l, or press c ENTER ) to keep the current background color. 

Mouse/Joystick: Point to the color you want to use for the screen's background 
and click. 

The canvas is once again blank (and may reflect a new background color) and you can 
go on to the next exercise. 

Drawing a Circle 

It's easy to select tools and patterns to enhance your drawings. For example, to draw 
a circle and fill it with colorful patterns, follow the directions below. 

[J Select Too l from the Menu Bar. 

Keyboard: Press CAI:lXD to move to the Menu Bar, use 8 to move the highlight 
to To ol and press CENTER J. 

Mouse/Joystick: Point to Too l on the Menu Bar and click. 
Eraser Brush 

l ine 

Rays 

Spray 

Magnify Sclec t Help 

53 



Sample Session 

A tool is the method you use to apply the "paint" to the canvas. 

Select the circle. 

Keyboard: Use the arrow keys to mo've the highlight to the circle icon on the Tool 
Menu and press (ENTER l. 

Mouse/Joystick: Point to the circle icon on the Tool Menu and click. 

The Tool Menu disappears, and the pencil is replaced by a cursor on the screen. You 
can move the cursor around the same as you did the pencil. 

Place the cursor near the center of the screen . 

Keyboard: Use the arrow keys to move the cursor to the center of the screen and 
press the space bar. 

Mouse/Joystick: Move the cursor to the center of the screen and click. 

Maneuver the circle until it fills most of the screen. 

Keyboard: Use the arrow keys to maneuver the circle. Press the space bar when 
the circle is the size and shape you want. 

Mouse/Joystick: Move the mouse or maneuver the joystick control, and click the 
button when the circle is the size and shape you want. 

Now you are ready 10 fill the circle with a color or pattern. 

Move to the Menu Bar and select T oo l . 

Select f i l l from the Tool Menu. 

Move to the Menu Bar and select P a l r: t t e. 
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The screen displays the colors and patterns from which you can choose to fill the circle. 

Select a color or pattern . 

Keyboard: Use the arrow keys to r. \ove the highlight until it rests on a color or 
pattern that you want to use, and 1hen press c ENTER 1 to select it. 

Mouse/Joystick: Move the highlight around on the palette until it rests on a color 
or pattern that you want to use, and then dick to select it. 

The palette disappears, and a cursor appears on the screen. 

Place the cursor inside the circle and click the button if you are using a 
mouse/joystick, or press the space bar if you are using the keyboard. 

The circle is now filled with the color or pattern you selected. Now, dear the circle 
the same way you cleared the previous drawing. 

Creating With Paint 

The next exercise shows how you can be creative with Paint. Use the methods you 
just learned to move around on the screen and to create a simple drawing of a 
locomotive. 

Move to the Menu Bar and select Too l . 

Select the open rectangle from the Tool Menu. 

Create a rectangle that resembles the one shown below. 

Keyboard: Press the space bar, then use the arrow keys to maneuver the rectangle. 
Press the space bar to set the ending point of the rectangle. 

Mouse/Joystick: Click to set the beginning point of the rectangle, and then 
maneuver it until it resembles the one shown below. Click to set the ending point 
of the rectangle. 

SS 



Sample Session 

You may have to practice awhile to get the rectangle the way you want it. If you make 
a mistake, you can erase your work by choosing und o from the Edit Menu and starting 
over again. Undo erases the last thing that you drew. 

Repeat the above procedure for creating the other rectangles needed for the 
locomotive as shown below. 

Now, you' re ready to put the wheels on the locomotive. 

Move to the Menu Bar and sele:.:t T o o l . 

Select the circle from the Tool Menu. 
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Use the open circle tool to place the wheels o n the train as shown below. 

Select the line tool from the Tool Menu and draw the cow catclwr. 

Now your train is complete and r<.'aJy tor the finishing touches. 

Move to the Menu Bar and select f i L .~ r t e . 

Select a color for the train. 

Move to the Menu Bar again and select Too l . 

Select f i l l from the Tool Menu. 

Move the cursor until it is in a rectangle and click (or press the space b.ir) to fill 
the rectangle with the color you chose. 

Repeat the same procedure until all the rectangles a re filled . 

Select s r,. o ~ from the Tool Menu and draw some smoke coming o ut of the 
smokestack. 

Note: If you are us ing a mouse or joystick, you must hold down the button 
while moving the cursor. 
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The drawing on your screen should resemble the one shown below. 

If you want to print the picture of the train, refer to Chapter 16, " Paint," in the 
Reference part. 

Now you're ready to create some pictures of your own, using the many tools and 
patterns that Paint has to offer. The two ''art" screens on the back cover of this manual 
were created using several tools and various colors and patterns from the Palette Menu . 

Exiting Paint 

Move to the Menu Bar and select 1 l i.! . 

Select ... : c , : from the File Menu. 

, r ,. ~ : :IJ 

Since this was only an example, select 11 0 . 

Keyboard: Use G to move the marker to n ,i , and then pres!> CENTEA J. 

Mouse/Joystick: Point to ' o (the marker automatically moves with the pointer) 
and click. 

You return to the DeskMatc Main Menu. 
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Setting Up a Budget 

This exercise teaches you how to set up a simple household budget using the Ledger 
application. The budget contains monthly expenditures and income and shows the 
results of calculations. 

Labeling the Spreadsheet 

Select Program Folder 3. 

Keyboard: Press CAL:JJE) to move to the Folder Window, and then use CD to 
move to Folder 3 and press c ENTER l. 

Mouse/Joystick: Point to Folder 3 at the Folder Window and click. 

Select s wap from the Disk Menu, and then select Ledger from the Desk.Mate Main 
Menu. 

Keyboard: Use the arrow keys to move the highlight to Ledger and press CENTER J. 

Mouse/Joystick: Point to Ledger and click twice. 

59 



Sample Session 

Cell 

Menu Bar 
Column~-l~jiii~~;;~;;;;;~;;;;;~::==~:: 

Row 

The Menu Bar contains access to various functions that you can use with Ledger. 

The screen layout is called a spreadsheet. Although you can't see them all on the screen, 
there are 99 columns and 99 rows in which you can enter data. Each cell (intersection 
of a column and row) can contain data of the following three types: 

number for numeric values only 

label for alphanumeric characters 

formula for formulas to be used in calculations 

You' ll learn how to enter data in all three types of cells and perform functions from 
the Menu Bar by working through the following exercise. 

Move the highlight to Column 2. 

Keyboard: Use G to move the highlight to Column 2. 

Mouse/Joystick: Point to Column 2 and click. 

Type Budget and press ~. 

This is the title for the budget you '11 create. 
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Use the keyboard arrows or point to the Menu Bar arrows and click to move to 
Row 3, Column 1, using the same methods as shown above, and begin. typing 
the data below: 

Mortgage CD 
Utilities CD 
Groceries CD 
Gas CD 
Chg Accts CD 
CD (for skipping a line) 
Total CD 
Income CD 
Balance (,..,.E,.,N,..T""'ER"'"'l 

The budget items you entered act as labels for the amounts you ' ll be entering. 

Move the highlight to Row 2, Column 2, and type Jan 1 G . 

Type Jan 15 G in Column 3. 

Type Feb 1 G in Column 4. 

r Type Averages in Column 5. 

Notice that the spreadsheet " scrolled" when you moved to Column 5. 

Use the left arrow key on the keyboard or point to the left arrow on the Menu 
Bar and click to scroll left until you see the labels. 
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Notice that you don' t see Column 5 now. It is still there, and you can see it if you 
scroll right again . 

Entering Amounts 
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Type the amounts in the columns indicated on the sample spreadsheet below. 

You don' t have to press CENTER ) after typing each number. Simply move to the 
next location for a number, and begin typing. 

Ledger recognizes these as numeric cells because each one begins with a number. 

E~.::<;,>e ~ 

.a~ : .an :~ :e~ : ~J~·~qc~ 

5jC.OC SOC ~S 
: :,:.:: 

Ii.!• ::er..· 1 e111 ' - ;.::. -. - 1 ZS . -- .J - -.. -= .... -
.:,tl ~ ... "~ J: •r 

J'-' 

,_ r:: s: .:.o 20C c: 

- • c. 
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Writing Formulas 

Next, you must tell Ledger the formula~ you want it to use in calculating the budget. 

Move the highlight to the Total row (Row 9, Column 2). 

Move to the Menu Bar and select b ' .., c k . 

Keyboard: Press CAJ:IXD to move to the Menu Bar. Use 8 to move to Bl ock 
and then press (ENTER J. 

Mouse/Joystick: Point to B lo c. k on the Menu Bar and click. 

Select for r. ~l a from the Block Menu. 

Keyboard: Use ffi to move the highlight to for mu l .:i and press CENTER ). 

Mouse/Joystick: Point to for mula on the Block Menu and cl ick. 

Entt!r /Ed i t Fo rmu la 

Type SUM(R3) (ENTER l. 

This formula indicates that you want to add the amounts in this column, beginning 
with the value in Row 3. After you press (ENTER J, the formula message disappears. 
The cell now shows • F • to indicate that it contains a formula . The formula you 
entered (SUM< R 3 >) appears at the bottom of the screen when that cell is 
highlighted. 

• Move the highlight to the Balance row (Row 11, Column 2). 

Select B loc x from the Menu Bar. 

r- Select f o rm u l a from the Block Menu. 

Type R10-R9 c ENTER l. 

This formula will subtract the total expenses from the income for that period. 
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You have entered labels, numbers, and formulas for your spreadsheet. Take just a 
moment and move from cell to cell. 

You'll notice that the bottom left corner of the screen indicates the type of cell. If the 
cell contains alphanumeric charac1 ers, it shows l ab~ l . If you have a number in the 
cell, it shows nu mber . When the cell contains a formula, that formula is displayed . 

Next, you'll copy some of the information in Column 2 to the other columns on the 
spreadsheet. 

Copying Formulas 

' Move to Row 9, Column 2. 
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Move to the Menu Bar and select !3 l o c k. 

Choose selec t from the Block Menu . 

Highlig ht the area indicated below. 

Keyboard: Use the arrow keys to m ove the highlight. 

Mouse/Joystick: Hold down the button and maneuver the mouse/joystick until 
the indicated area is highlighted . 
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~ Move to the Menu Bar and select B lo c k. 

Select copy from the Block Menu. 

The text remains on the screen tut is also in a copy buffer and will remain there. 
You can copy it on the spreads~.eet as many times as you wish until you choose 
something else to be copied. Then the new selection replaces the old information 
in the buffer. 

Move the highlight to Row 9, Column 3. 

L Move to the Menu Bar and select B l o c k . 

r Select i n s er t from the Block Menu. 

The income figure is copied to Column 3, but the cells that contain formulas do 
not show amounts until you calculate. 

Move the highlight to Column 4, and insert the information contained in the copy 
buffer by again choosing i n s c r t . 

You don' t have to choose copy again. The information in the buffer remains there 
until you copy over it. 

Calculating the Totals 

Move to the Menu Bar and choose Ce l l s . 

r J Choose ca l cu lat e from the Cells Menu. 

The calculations performed with the formulas you entered appear in the formula cells. 
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Averaging Expenses 

Follow the directions below to find thE· average expenses for each pay period . 

Highlight the block of nine cells sta;·ting at Row 3, Column 5, and ending at Row 
11, Column 5. 

Move to the Menu Bar and select B ~ o c k . 

Select f o rm u l a from the Block Menu. 

- Type A VG(C2) c ENTER l. 

The formula is entered into all nine cells. 

Move to Row 8, Column 5, and delete the formula in the cell. 

Select the de l et e option from the Block Menu to delete the formula . 

Now perform the calculation by following the directions in " Calculating the Totals." 

Using the 80-Column Format 

If you want to see the spreadsheet you created in an 80-column format, follow the 
instructions below: 
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Select the Icon Bar. 

Keyboard: Press CAl:I)G). 

Mouse/Joystick: Point to * and click. 

Select the Display utility from the Icon Bar. 

Keyboard: Use 8 to move the highlight to the Display icon, and press CENIEID. 

Mouse/Joystick: Point to the Display icon, and click. 
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Select the 80-column format. 

Keyboard: Use G to move the check to the 80-column box, and press CENTER J 
to select it. 

Mouse/Joystick: Point to the 80-cola mn box and click. 

L • Return to the Icon Bar. 

Keyboard: Press I ENTER J again to re turn to the Icon Dar. 

Mouse/Joystick : Point to Pre s s ENrER t o con t i nue and click. 

Return to the Ledger application. 

Keyboard: Press I BREAK J. 

Mouse/Joystick: Point to * and click. 

The spreadsheet you created now appears on the screen in the new format as shown 
below: 

Return to the Display utility on the Icon Bar and reset the format to a 40-column setting; 
then return to Ledger again. 
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Printing the Spreadsheet 

If you have a printer and want a cop~' of the spreadsheet you just created, follow the 
instructions below. If you do not wart a copy of the spreadsheet, proceed to "Exiting 
Ledger." 

Move to the Menu Bar and select F i Le. 

Select print from the File Menu. 

After your printout is completed, you return to Ledger's Main Screen . 

Exiting Ledger 

You can save data files in folders other than the first one. Save this ledger file in Folder 
2 by following these instructions. 

Move to the Menu Bar and select F 1 l e . 

Select c lose from the File Menu. 

sa ve? ·'ye s no 

Select y e s to save the budget file . 

Specify Folder 2 by typing, 2: BUDGET ! ENTER I. 

You return to DeskMate's Main Menu. If you check the contents of Folder 2, you'll 
see the BUDGET file. 
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Sending a Message 

Telecom lets you communicate with other computers or with the many computer 
services that are available. In this chapter, you'll see an example of how you could 
use Telecom to communicate with a large computer service. Since you can't use Telecom 
without a computer service or another computer, just read this chapter now. Then, 
after you have your modem and are a service user, come back to this section and try 
actually using Telecom. Before using Telecom, be sure that you read the information 
that came with your modem, that you know how to connect it, and that you know 
the modem settings your computer service requires you to use. See Chapter 18, 
" Telecom" for information on connecting your communication equipment. 

Setting Up for Communication 

When you are ready to set up for communication to another computer, follow these 
instructions. 

Select from the Disk Menu and then select Telecom from DeskMate's Main 
Menu (in Folder 4 if you are using a two-drive system). 

Keyboard: Use the arrow keys to position the highlight on the Telecom icon and 
press ! ENTER ). 

Mouse/Joystick: Point to the Telecom icon and double click. 
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Status Settings 

The top line of the screen is the menu bar, containing the names of the options you 
can use, plus access to a help window and the icon bar. The main part of the screen 
contains Telecom's status settings. Before you can communicate with another computer, 
you need to select the settings that your computer service requires. The screen above 
shows the default settings. 

Enter your user ID and password as your computer service recognizes them. 

Keyboard: Press CD to move the cursor to the ID and password fields. Press 
c ENTER J to edit the fields. 

Mouse/Joystick: Point to the ID and password fields and click. 

Telecom highlights the setting it is currently using and lets you change it simply by 
highlighting a new setting. 
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Set the Baud Rate to the transmission speed that your service uses. 

Set the Word Length, Parity, ASCII, Line Feed, Echo, and Wordwrap to match 
the settings that your service reyuires you to use. 
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An example of these settings is: 

Word Length: 7/1 
Parity: Even 
ASCII filter: Off 
Line Feed: Off 
Echo: Off 
Wordwrap: Off 

Type /T2 at the Serial Port prompt. 

The ASCII filter strips off all characters over 7F hex and control characters other than 
line feed, carriage return, backspace, tab, and formfeed . 

In terminal mode, or memory mode, while displaying data on the screen, if a word 
cannot be displayed fully in the current line, it will be displayed in the next line. 

Getting Ready to Call 

The status screen is only one of three Telecom screens. The other Telecom screens are 
the tem1inal screen and the memory screen. To call (or go "online" with) another computer, 
you need to be in Telecom's tenninal mode. To enter terminal mode, move to the 
terminal screen. 

Move to the Menu Bar, and select v i e w. 

Keyboard: Press CA.aXD to move to the Menu Bar. Use 3 to move the highlight 
to Vi ew, and press !ENTER !. 

Mouse/Joystick: Point to Vi e " on the Menu Bar and click. 

Choose t e r rn i n a l from the View Menu. 

Keyboard: Use OJ to move the highlight to t e rm i n a l , and then press I ENTER l. 

Mouse/Joystick: Point to t e r mi n a l on the View Menu, and press I ENTER l. 
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If you were going online with another small computer, you would need to call and 
connect to that computer. To go online with a large computer service, the steps are 
more involved. They are: 

Call and connect to the service's 11etwork. 

This connects you to the same network that your service's computer is using. (This 
is usually called the "host" computer.) 

You might, for example, connect to a network by setting your modem's 
Originate/Answer switch to Originate. Next, you would dial the network's phone 
number, and wait for a high-pitched tone. At that point, you would connect to 
the network in the way your modem manual ins tructed you . 

Access the host computer. 

This forms a " relay" connection between you and the host computer. 

Generally, the steps for accessing the host computer involve pressing a key (like 
(ENTER )) immediately after connecting and then waiting for a message asking you 
for your user ID. 

Log on to your service. 

This identifies you to the host computer so that you can use its services. 

To log on, you are usually asked for your user ID and p.1ssword. 

If the steps you used for going online did not work, d isconnect your modem from 
the telephone and try again. When you try again, check the following: 

• Be sure your modem is connected properly. 

• Be sure your status settings are set properly for the service you are using. 
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Communicating 

You should now be communicating with the other computer. Any information or 
prompts that appear on your screen nov •are coming from your service-not Telecom. 

After preliminary questions and messages, some services display "top menus." These 
menus usually lead to a series of submenus . You can usually choose a menu selection 
or enter a command such as BYE to end your session with the service. 

Going Offline 

If you were going "offline" from another small computer, you would simply need 
to disconnect your modem. To go offline from a computer service: 

Log off the service. 

This lets the service know to quit charging for your time. To do this, you would 
usually return to the top menu or to a prompt at which you could enter a command. 
Next, you would type the command your service requires for logging off. Most 
of the time, the service logs off and displays the amount of time you used it. 

Note: Be sure to disconnect your modem. This Jets you free your telephone 
line for other uses. Even though you have finished communicating, your 
modem is still connected to the other computer. The way to disconnect your 
modem from the host computer depends on the kind of modem you are using. 
See your modem manual for instructions. 

Viewing What Was Transmitted 

Now that you have logged off, you can view the information that was transmitted 
between you and the service at your leisure. To do so, move to Telecom's memory 
screen. 

Move to the Menu Bar and select v 1 1. ·.~ . 
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l. Choose rn em o r y from the View Menu. 

This screen lets you scroll through the information that was transmitted in the same 
way you would scroll through a DeskMate Text file. 

The contents of this screen will be era~.ed when you exit Telecom. For this reason, when 
you exit Telecom, you have the opportunity to save the contents of the memory screen. 

Using the 80-Column Format 

If you want to see a file in Telecom in an 80-column format, follow the instructions 
below: 

L- Select the Icon Bar. 

Keyboard: Press CAilX:!) . 

Mouse/Joystick Point to * and click. 

Select the Display utility from the Icon Bar. 

Keyboard: Use 8 to move the highlight to the Display icon, and press (ENTER J. 

Mouse/Joystick: Point to the Display icon, and click. 

- Select the 80-column format. 
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Keyboard: Use 8 to move the marker to the 80-column box, and press (ENTER J 
to select it. 

Mouse/Joystick: Point to the 80-column box and click. 

Return to the Icon Bar. 

Keyboard: Press ! ENTER J again to return to the Icon Bar. 

Mouse/Joystick: Point to Press ENTER to cont i nu e and click. 
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Return to the Telecom application. 

Keyboard: Press (BREAK ). 

Mouse/Joystick: Point to • and click. 

The Telecom file now appears on the screen in the new format. 

Return to the Display utility on the Icon Bar and reset the format to a 40-column setting; 
then return to Telecom again . 

Exiting Telecom 

To exit Telecom, follow these steps. 

At the memory screen, move to the Menu Bar and select F i l e. 

Select c los e from the File Menu. 

Save me mory? ... ; yes no 

Select no . 

Keyboard: Press 8 to move the marker to no, then press CENTER !. 

Mouse/Joystick: Point to no and dick the b\ltton. 

You immediately return to DeskMate's Main Menu. 
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Renaming a Data File 

Renaming a data file is easy with DeskMate. A data file contains all the information 
that you enter while working in a DeskMate application. You can't rename program 
files . 

At DeskMate's Main Menu, move the highlight to the Folder Window and select 
Folder 1 (for one disk drive) or Folder 2 (for 2 disk drives). 

Keyboard: Press CALlB to move to the Folder Window. Use ffi to move the 
highlight to Data Folder 1 and press ! ENTER I. 

Mouse/Joystick: Point to Folder 1 on the Folder Window and dick. 

'~.fm .• . • .. .. 
D a ta Ill•• In fo ld •,.. I f 

··------------.... Tr"••h 

The file that you created in Text Editor ( l c t t e r ) appears along with the application 
icon. 

Highlight ... ~ t t " r . 

Keyboard: Use the arrow keys to make sure the highlight is on Let t er . 

Mouse/Joystick Point to Le • t ,, r and click. 

77 



Sample Session 

78 

Move to the Menu Bar, and select . ,, , . 

Keyboard: Press CAl::OOJ to move to the Menu Bar. Be sure the highlighf is on 
F: le s, and then press c ENTER J. 

Mouse/Joystick: Point to ~ l •' on the Menu Bar and click. 

Select r en. r - from the Files Menu. 

Keyboard: Use ffi to move the highlight to 

Mouse/Joystick: Point to , 1 , · ' and click. 

f'jT;' s I :C'!'1 C mll! 1.!J13!11 

.... files In f older t I 

r== 1 Jpf'ffll't• r1 
... r, : - LJ 

Edit cfe-st1n•tton n.u•e or 
Pr .. .. s CBAlAK~ to c.;anc;;PI 

· and press CENTER l. 

·~ () {.) (~) I 

l d~•l 1 

_____________ _. Tr• ah 

Type the new name for the file, Text, and then press CENTER ) so that the remainder 
of the characters in the old filename will be deleted. 

The new filename is recorded 0 11 the disk, and the Data Folder 1 screen reappears 
with the new name. 

Select Folder icon 3 to re-display the contents of Program Folder 3 in the directory 
window. 



Reference 
This part contains very detailed information about moving around 
on Deskmate's screens when using a keyboard or a mouse/joystick, 
and each application and function in DeskMate. The information for 
the applications is usually presented in order of its appearance on 
the screen (not necessarily in the order in which it is to be 
performed}. 

The back up instructions and startup procedures for DeskMate are 
explained thoroughly in "Getting Started" in this manual, so refer 
to it if you need help in those areas. 
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Chapter 11 

IJlll Moving Around 

When you first see the DeskMate Main Menu (on Diskette 1), the application on the 
diskette is surrounded by a box and can be selected. Throughout DeskMate, you can 
move the highlight, box, "check" mark, or other method of emphasis around on the 
screen and make selections with the keyboard or a mouse or joystick. After you loaded 
DeskMate (in Chapter 1, "Loading DeskMate"), you chose the device you want to 
use with DeskMate. The instructions below contain specific information for the device 
you'll be using. 

Using the Keyboard 

Use the chart below as a quick reference when you want to know how to move around 
on the screen using the keyboard . (Any exceptions are discussed under specific 
applications.) 

Press: To move the highlight or cursor: 

Back one character, erasing the character beneath it 

To select the Icon Bar 

To select the Help Window 

To the Menu Bar 

To the Main Menu from the Menu Bar 

To the Folder icons on the Main Menu 

To the Main Menu from the Folder icons 
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Press: To move the highlight or cursor: 

m Up one line or item 

m Down one line o: item 

Left one position 

G Right one position 

Up one screen of data 

cs81Ft1ffi Down one screen of data 

One word to the left or one screen to the left 

csHIFT JG One word to the right or one screen to the right 

To the first item in a file 

To the last item in a file 

To the left margin of the screen 

To the right margin of the screen 

To select a function or information in DeskMate using the keyboard, use the arrow 
keys to emphasize the desired function, and press (ENTER l. If you choose a function 
that has a menu, it will appear, and you can then use the arrow keys to move to the 
desired option and press (ENTER l to select it. 

You can perform the functions with numbers beside them without accessing the menu. 
Select the information with which you want to use the function, and then press 
CArn number. This method is most convenient when you are familiar with DeskMate. 
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Typing Text 

You can use Desk.Mate as you would a typewriter to enter text in any application. Below 
are two things you need to know when you a1e typing with Desk.Mate. 

Use: To: 

Switch between insert/overstrike 

Switch between upper/lowercase 

In insert mode, characters you enter are inserted at the cursor position, pushing existing 
characters toward the right. The cursor appears as a vertical line positioned between 
two characters, at the point where characters are inserted. 

In overstrike mode, a character you enter replaces the character under the cursor. The 
cursor appears as a reverse video block. When using lowercase, you can hold down 
(SHIFTJ while typing a letter to capitalize it, much like a ISAIFTJ key on a typewriter. 

Using the Mouse/Joystick 

When you use a mouse or joystick, a small pointer appears on the screen, and you 
can move it around to select Desk.Mate functions or information. You need to be familiar 
with the following techniques for moving the pointer: 

point 

click 

double click 

press 

drag 

Move the mouse or joystick until the tip of the pointer rests over 
the desired object. 

Quickly press and release the button. 

Click the button twice consecutively. 

Press and hold down the mouse or joystick button. 

Press and hold down the button while you move the mouse or 
joystick in the desired direction. 
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To select a function or information in DeskMate using a mouse or joystick instead of 
the keyboard, point to the desired function or information, and then click the button 
on the mouse/joystick. If you choose a function, the menu will appear, and you can 
then select an option by pointing to it and clicking. 

You can perform the functions with numbers beside them without accessing the menu. 
Select the information with which you want to use the function, and then press 
a:rn number. 

The chart below shows how to use the mouse/joystick with a Menu Bar's function 
arrows. You may need to consult it from time to time until you become more familiar 
with DeskMate. 

Point to: Then: To move highlight: 

0 Click Up one line or item 

0 Click Down one line or item 

0 Click Left one position 

0 Click Right one position 

0 Double Click Up one screen of data 

0 Double Click Down one screen of data 

0 Double Click O ne word to the left or one screen to the left 

0 Double Click One word to the right or one screen to the 
right 
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Chapter 12 

The Main Menu 

After you load DeskMate, the Main Menu is displayed. 

Menu Bar 
Progr-s In folder 3 I 

Directory window Folder icons 

__________________________ .....,. Tra&h 

The Main Menu is the control center for the entire system, enabling you to access any 
part of DeskMate you want to use. It is divided into three parts: the Menu Bar 
(containing functions), the Directory window (showing the contents of a program or 
data folder), and the Folder Window (used to select different data or program fold~rs). 
The contents of Program Folder 113 (the programs on Diskette 1) always appear in the 
Directory window when you first load DeskMate. 
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The contents of Folder #4 (the program on Diskette 2) appear as shown below. 

Menu Bar __ 

Directory window 

r.1 ..... r o fdrr l>i s 

- Pro9ra11s lri folder 4 t 
·~:i:~ 
~ 

Calendar 

-= 
Text 

-'9 
Flier 

"/ • 

"'·' ' ...... 
Paint 

-------------~ Traah 

Folder icons 

You can reach the Folder Window by pressing CAaB (if you are using the keyboard). 
Use m and CD to move the highlight to the Folder you want, and then press 
c ENTER J to select it. 

If you are using a mouse/joystick, just point to the folder icon you want and click. 

The Menu Bar 

A Menu Bar, like a restaurant menu, contains various items from which you can choose. 
You can reach the Menu Bar in one of two ways: 

Keyboard: Press CAIJXI). 

Mouse/Joystick: Point to the file or function you want, and then click to select it. 
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Files Menu 

Choose the Files Menu when you want to perform a task involving a program or data 
file . After you select the program or data folder that you want, select the desired file 
on the Directory window. Then, select Fi.es from the Menu Bar. 

When the Files Menu appears, you can move to the option you want and select it. 
The options are: 

op en 

c os e 

3 cop y 

Opens the file you selected. (You can also open a file by selecting its 
icon and pressing c ENTER J or by pointing to the icon and double 
clicking. If you are cpening a data file, its associated program is opened 
at the same time. The main screen of the program (with the chosen 
data if you opened a data file) is displayed. 

Exits Desk.Mate. 

Makes a duplicate of the selected file. 

Follow the instructions below to copy from the Files Menu on the Menu 
Bar. 

1. Move to the file you want to copy, and then select copy from the 
Files Menu on the Menu Bar. 

2. A window appears, and you can edit the name of the file you are 
copying. (You cannot change the name of a program file.) 
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5 de l e te 

3. When the information is correct, press (ENTER J to copy the file. 
Be sure that you have a formatted diskette in the second drive. 

If you are using one disk drive, the copy folder number and 
filename must be he same as the destination folder number and 
filename. The foll >wing message appears: 

F o l de r s an d fi Le s dre ide nt i c al , 
is t hi s a s in gl e d is k c op y? 

"' Yes . No 

4. Select an option, and press ! ENTER J. You return to the Main 
Menu. 

Press C BREAK l to cancel the copy option and return to the Main 
Menu. 

Follow the instructions below to copy using the mouse/joystick. 

1. Move to the file you want to copy, and hold down the button on 
the mouse/joystick until the box changes its color. 

lf you highlight a program file, the data folder icons disappear. 
If you highlight a data file, the program folder icons disappear. 

2. Drag the box (representing the file) to the folder to which you want 
to copy the file. 

3. Release the button when the box is at the correct folder. 

Follow steps 2 through 4 for keyboard users to complete the copy 
procedure. Click wherever (ENTER J is mentioned. 

Deletes the selected file. 

WARNING: Do not delete application (program) files unless you are sure you 
have a copy of the application on another diskette. 
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Follow the instructions below to delete using the keyboard: 

1. Move to the file you want to delete, and then select d e l e t e from 
the Files Menu on the Menu Bar. 

A window appears showing the information on the file . 

2. Press (ENTER J to delete the file and return to the Main Menu. 

Press CBREAK J to cancel the deletion and return to the Main Menu. 

Follow the instructions below to delete using the mouse/joystick. 

1. Move to the file you want to delete, and hold down the button 
on the mouse/joystick until the box changes its color. 

2. Drag the box to the "trash can" icon in the lower right corner of 
the screen. 

3. A window appears showing information about the file. 

4. Point to ! ENTER J and click to delete the file and return to the Main 
Menu. 

Point to (BREAK J and click to cancel the deletion and return to the 
Main Menu. 

Renames the selected data file. (You cannot rename program files'.) 
Move to the file you want to rename, and select the Files Menu from 
the Menu Bar. After you select rename from the Files Menu, a 
window appears, and you can type the new filename. Press (ENTER J 

to rename the file, or press C BREAK l to cancel the rename option and 
return to the Main Menu. 

Displays the date and time at which the file was last updated, its name, 
and its size in characters. Press any key to return to the Main Menu. 
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' help Displays a help window that features specific instructions for using 
the Files Menu. Press any key to see the next page of help information. 
Press ffi to return to the Main Menu. You can also press I BREAK I, or 
move the pointer outside the help window and click to return to the 
Main Menu. 

Press (BREAK I, or move the pointer outside the Files Menu and click to exit the Files 
Menu. 

Folder Menu 

Choose the Folder Menu to print a list of files in a folder or to sort data folder files. 
First, select a folder. 

Keyboard: Press CAJ:IB, and then use CD and m to choose the desired folder, and 
press c ENTER l. 

Mouse/Joystick: Point to any folder icon and click. 

After you select the program or data folder, move to the Menu Bar, and select F o l de r. 
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When the Folder Menu appears, move the highlight to the option you want, and press 
(ENTER I or click. 

2print Prints the filename, creation date, and size in bytes of each file in the 
selected folder. If you sele:ted a program folder, the information for 
each program file and its a~.sociated help file is printed. When printing 
is complete, the Folder Menu disappears. 

8 so rt d ata Sorts all files in a selected data folder either alphabetically (alpha) or 
by program type (icon). Select the way you want the folder to sort. 
You return to the Main Menu. 

' h e l p Displays a help window that features specific instructions for using 
the Folder Menu. Press any key to see additional pages of help 
information. Press CBREAK I, or move the pointer outside the help 
window and click to return to the Main Menu. 

To exit the Folder Menu, press (BREAK I, or move the pointer outside the Folder Menu 
and click. 

Disk Menu 

Choose Di s k from the Menu Bar when you want to initialize or back up a diskette, 
or when swapping DeskMate diskettes. 

Move the highlight to the option you want to use, and press CENTER l or click. 

i n i t i a l i z e Initializes (formats) a diskette for storing information. 

backup Makes a copy of a diskette. 
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s wap 

., f, el o 

Enables you to exchange a DeskMate program diskette for another. 
The new diskette must also contain DeskMate programs. 

Displays a help window that features specific instructions for the Disk 
Menu. Press any key to see add tional pages of help. Press c BREAK l, 
or move the pointer outside th( help window and click to return to 
the Main Menu. 

Help Window 

Selecting ' from the Menu Bar accesses a help window containing specific information 
about the Main Menu. Press any key to see additional pages of help information. Press 
c BREAK l, or move the pointer outside the help window and click to return to the Main 
Menu. You can also press CAJ:lXI) to access the help window screen. 

Scrolling Arrows 

Note: Only mouse/joystick users can access the scrolling arrows on the Menu 
Bar. 

Select 0 or Q to highlight the program or data icons that appear above or below the 
information currently highlighted. Point to the scrolling arrow that you want to use, 
and click. For more information about the scrolling arrows, see Chapter 11, "Moving 
Around." 
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Icon Bar 

Select the icon bar ( •) by using one of these methods. 

Keyboard: Press CAJ:::IX!J. 

Mouse/Joystick: Point to .. and click. 

The Icon Bar contains utilities that you can use at any time while using DeskMate. 
If you don' t want to select a utility, you can reselect * (or press (BREAK J) to return 
to the application. The next section, " Icon Bar Functions," explains each Icon Bar utility 
in detail. 

1.:-:J 
~ Icon Bar Functions 

The Icon Bar contains six utilities that you can use at any time, in any application . 
Select the Icon Bar from the Menu Bar of the application you are currently using. 

To use a utility, select its representative icon. To return to the Icon Bar, press ClIB£AKJ. 
You can choose the help window ('1 ) from the Icon Bar before selecting an Icon Bar 
function. 
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The folder utility lets you work wit.' the folders being used by DeskMate. Working 
with folders can become technical. We suggest that you become familiar with 05-9 
by reading the 05-9 manual and by reading Appendix B in this manual. After you 
select the folder utility, you see: 

A path11nme identifies a specific folder created by the OS-9 operating system and always 
begins with a disk drive number followed by a name. It also gives directions to 
DeskMate and 05-9 on how to find nn existing directory or where to put a new one 
on the disk. 

Note: 05-9 is the computer operating system that DeskMate uses. 

You can type the names of one or more folders being used by DeskMate, specify an 
existing directon; (the 05-9 system term for " folcer"), or create new directories (thus 
creatirlg an empty folder). 

If you enter a pathname for a folder that does not exist, you are asked if you want 
to create a new directory. 
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Caution: Once you create a directory, you cannot delete it unless you have 
an 05-9 system diskette. 
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After the directory is created, you can enter another .pathname. Refer to Appendix 
B for more specific information about the 05-9 operating system. 

The options on the Folder utility screen are: 

e d i t Lets you change the dire( tory information for a folder . Use the arrow 
keys and I ENTER 1, or point and click to highlight the folder you want 
to edit. Be sure the check is at the e d i t option, and press c ENTER 1 
or click. When the information is correct, press c ENTER J to record the 
changes, or press ameAR1 to cancel the edit option. You can then 
choose another option from the Folder utility. 

don e Tells Desk.Mate that all information for the files is correct. Be sure the 
check is at the do ne option, and press CENTER J or click. You return 
to the Icon Bar. You can choose another function or reselect the Icon 
Bar to return to the previous application. 

ca n c e l Cancels all changes you might have made while in the Folder utility. 
(You cannot cancel a created folder.) Be sure the check is at the cancel 
option, and press c ENTER 1 or click. You return to the Icon Bar. 
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~. . Printer 

The printer utility lets you define in! ormation that determines the w ay your printer 
and DeskMate will interact. Select the printer utility from the Icon Bar. 

Left Margin 

Printer 
line w idth 

Top Margin 

Printed lines 
per page 

Total lines 
per page 

You can type over the existing default value and press CENTETO, or press CENfflO alone 
to move to the next prompt. 

I . • I 

• l 

t" t I f • "" 1 ,. ll" I I • 

The number of spaces from the left edge of the paper 
to the first character position for printing. 

The number of characters that you want to print on 
one line. 

The number of blank lines you want to leave at the 
top of each page. 

The number of lines you want printed on each page. 

The length of the paper in print lines. 

When you finish setting up the screen and press c ENTER J at the last prompt, other 
printer settings appear in the order shown below, and you can enter new settings or 
press CENTER J to keep the old ones. 
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P r i n t e r baud r a t e See the owner's manual for your printer to be sure you 
have the proper setting. DeskMate can use 600, 1200, 
2400, 4800, or 9600 baud rate settings. When the setting 
is correct, press CENTER l or click to go to the next 
setting. 

Pr i n t er .pa pe r Press (ENTER) or click on the continuous option to 
indicate that you are using continuous feed paper. 
Move the "check" to the single sheet option if you 
want to stop the printer after each page to insert 
another sheet of paper. 

P r i n t e r c a r r i age w i d t h The number of characters that your printer is capable 
of printing on one line of your page. This is usually 
set at 80 or 132 columns. Press (ENTER) when the 
setting is correct. 

P ,. 1 ,.., t e r de v 1 c e Type /P to select the printer port, or type a filename 
to "print" information (send output) to a text file. 

Press CBREAK l to cancel the changes and return to the Icon Bar. 

Press ! ENTER I to record the changes and return to the Icon Bar. 

The Calculator utility lets you use your computer as a hand-held calculator. You can 
access the calculator while using any DeskMate application without interrupting the 
screen you are currently using. The calculator uses a ten-digit display (no commas) 
and a floating decimal point format. 9,999,999,999 is the larges t number that you can 
enter or accumulate, and 0.000000001 is the smaJlest. 
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After you select the Calculator utility from the Icon Bar, the calculator appears. 

Appltc•hon : 

O"LEDGIR 

il!l ~ liJl;Jr.flij 

.i..l.:.l:Jl:Jl!lt;jl!ll 

iDUl!:.tl!l ll llm 
..i..Dl&l ll ll D ll.llJ.lj 

::; Changes the sign (negative or positive) of a nu mber. 

MC Clears memory contents. 

Mk Recalls and displays memory contents. 

M- Subtracts a number from memory. 

M• Adds a number to memory. 

C [ Clears current entry (operand) for easy correction. 

CA Clears accumulator amount and resets operator. 

cmrr:JD Performs the same function as "equals" ( :a ). 

Keyboard: Type the number or function (for example, M - to subtract a number from 
memory). 

Mouse/Joystick: Point and click to select a number or function. 

Press (BREAK) to exit the Calculator utility and return to the Icon Bar. 
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~Time 
The Time utility lets you set the date and time, resetting the date and time you entered 
at the startup of DeskMate. (You can see the date and time that you created or updated 
a file when you view the status of the file .) Select the Time utility from the Icon Bar. 

Da t e is : 
T i me i s : 

P r e s s i~-=: t o c on t i nu e 
Pr es s ~B_REA-K t o cance l 

To change the current date, simply type the new date (up to 8 characters) and press 
(ENTER J. For example, you could type 7/03/86 c ENTER J. 

Enter the time in the format you choose (up to 11 characters). For example, you could 
type 12:30 P.M., 12 AM, or 12:30:05 p. 

Note: Military time cannot be set in DeskMate. Use only the hours 1-12. 

After you press c ENTER J at the time prompt, the information is recorded, and you 
return to the Icon Bar. 

Press (BREAK J to keep the old date and time and return to the Icon Bar. 

Cl 
~Display 
The Display utility is designed to let you change the resolution on your screen (in 
Telecom, Text, and Ledger) to a 40- or 80- column format and change the 16 available 
colors on the Color Palette. 
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Select the Display utility from the Icon Bar. 

Window Bars Mode indicator 

(Inn nm 
_, 

nod• • Hadlfy ~alar 

Foreground Background 

!DJ • • "' Command Bar 

Color Palette 

(4r. re; Mlt [(4 

I I I • •;. • • • ••• R c; ~ 

• • • PrP-.•• I fMllRI tn continue 
Pr.,..,.,. C ltP.fRIO ta r.~ncPI 

R,G,B Color Scales 

Note: See this screen on the back cover of the manual for a true representation 
of colors . 

The name of the application you are currently using appears at the top of the screen. 

Resolution - You can change the screen resolution between 40- and 80-column formats 
in some DeskMate applications. The chart below shows, at a glance, the resolution 
formats that can be used for each application. 

Application: Uses: 

Calendar 40-Column only 
Filer 

Telecom 40- or 80-
Text Column 
Ledger 

Paint (Not 
Applicable) 
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The 40-column format is automatically set in Calendar and Filer, and you do not have 
the option of selecting an 80-column format. Paint requires a special resolution format, 
so the resolution settings do not appear on the Display screen when you are using 
the Paint application. 

If you are currently using Telecom, Tex1, or Ledger, you can switch between the 40-
and 80-column formats as shown below: 

Keyboard: Use G or G to move to and choose a 40- or 80-column format. Press 
(ENTER I to select the format setting. 

Mouse/Joystick: Point to the desired choice and click to choose a 40- or 80-column 
format. 

To move to the Color Palette function, press the space bar if you are using the keyboard, 
or point and click. 

To exit the display function and return to the Icon Bar, press (BREAK I or point to 
Press r [ATIK' to can c e l. To return to the application you were using, press 
CBREAK I or point to * on the Icon Bar and click. 

Color Palette - The Color Palette consists of 16 colors and Red, Green, and Blue Color 
Scales with which you can alter any of the available colors. The top four colors are 
specifically designated for the screen's background (BG), foreground ( F G), window borders 
(W B), and Command Bar ( c B). The following chart shows the number of available colors 
in each application (with the appropriate resolution setting). 
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Application Resolution Available Colors 

Calendar 40-column 4 (background, 
Filer (automatically foreground, window 

set) borders, and Command 
Bar) 

Telecom 80-column 2 (background and 
Text foreground) 
Ledger 

40-column 4 (background, 
foreground, window 
borders and Command 
Bar) 

Paint automatically 16 colors 
set for 16 
Color Format 

Note: If you are changing the background and foreground colors of an 
application, the Display screen reflects the changes as you adjust the Color 
Scales. If you are using the keyboard, press ~ at any time to restore 
the previous colors to the screen. If you are using a mouse/joystick, click on 
the top bar of the screen (containing the name of the application which you 
are currently using) to restore the previous colors. 

If you are currently using the Paint application when you alter a color in the Display 
Mode's Color Palette, the change is reflected in Paint's own Color Palette when you 
return to the Paint application. 

Use the arrow keys on the keyboard, or point and click to move the highlight within 
the Color Palette. As you move the highlight from color to color, notice that the RGB 
Color Scales change to reflect the highlighted color's red, green, and blue color levels. 

When the highlight is on the color you want to change, press the space bar or point 
and click to move the highlight to the RGB Color Scales and then follow the instructions 
below to alter the amount of red, green, and blue in the chosen color. 
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Experiment with the Color Scales to learn more about combinations of colors in the 
Color Palette. 

Keyboard: 

Use To: 

EJ Move right, among the R, G, and B (Red, Green, and Blue) Color 
Scales. 

G Move left, among the R, G, and B Color Scales. 

CD Move to a higher (brighter) level of color. 

CD Move to a lower (dimmer) level of color. 

CAJ::I:G Move to R, G, B Color Scales. 

CAL!B Move to the Color Palette. 

CA1:lXD Move to the resolution function (if applicable). 

I ENTER I Save all changes and return to the Icon Bar. 

I BREAK l Exit the display function without saving the changes and return to the 
Icon Bar. 

space bar Moves the highlight between the resolution function (if applicable), 
the Color Palette, and the R,G, and B Color Scales. 

Press ! BREAK J to return to the application you were using (and the new color display, 
if any). 

Mouse/Joystick: To move the selector to the desired color level, click on R, G, or B 
to choose Red, Green, or Blue and then click on the appropriate area of the scale. (You 
can also click and hold within the selector and drag the selector until you reach the 
desired color level.) The color you chose from the Color Palette changes as you move 
the select bar among the color levels. 
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To exit the display function and save the changes (if any), click on Press Cf.N.Il_l[ 
t o c on t i nu e . You return to the Icon Bar. 

To exit the display function without saving changes, click on Press filll;AJS..., to 
canc e l. You return to the Icon Bar. 

To return to the application you were using (and to the new color display, if any), 
press c BREAK J or point to • on the Icon Bar and click . 

• Cursor Control Option 

This utility specifies the device with which you intend to run DeskMate. Select the 
Cursor utility from the Icon Bar. 

Choose type of cursor 
contr ol device: 

-~ M o u s e o r J o y s t i c k 
, Ke yboard only 

Press ENTER to continue 
Press B_R_E_AK to can c e l 

Use CD and CD on the keyboard or the mouse/joystick to choose the device you want 
to use, and press CENTER ) to return to the Icon Bar. Choose another Icon Bar utility 
or press CBREAK J to return to the application you were using. You can use the keyboard 
in any DeskMate application, no matter which option you choose. 
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Help Window 

Selecting ? displays a help window conta.ning specific information about the Icon Bar. 
Press any. key to see the next page of help information. 

To exit the window: 

Keyboard: Press c BREAK I. 

Mouse/Joystick: Move the pointer outside the window and click. You return to the 
Icon Bar and can make another selection. 

I (*) I Icon Bar 

Select this icon or press c BREAK I to return to the application you were using. 
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Calendar 

The Calendar application will replace your tattered and torn desk calendar. You'll never 
be late again or forget a birthday or anniversary because your desk calendar was buried 
under paperwork or because you couldn't read the scribble. Your DeskMate Calendar 
appears in seconds, and you can review or schedule events for any month, day, or 
year you choose by merely moving the cursor through a monthly calendar screen. You 
can also print monthly, weekly, or daily reports if you need a "reminder" to take with 
you. 

Instructions 

Choose the Calendar application from DeskMate's Main Menu. 

Menu Bar (~~I 1 .S1..~~ 

Calendar 

r~ AUGU S T l!Hl6 

~ 
~-.-: r"'I·· I 2 

r-·· 3 ... 5 6 ? • =J 9 

~"' t • 18 11 12 1 3 1-1 15 16 
... j I? 18 1 9 29 JI 22 :73 
t .. 2-1 25 26 21 711 :79 3 8 tf ., 31 .t~ ...... '· . •. 
r-~!J>.A_°':' . - • 

I t"!~ l, 

L ~ 
Current day and date 

Text area 

When you first enter the Calendar application, the system month and day appear. The 
entire month appears in the middle, the bottom left block shows the day and date, 
and the space to the right displays daily memos (if any). Use the techniques described 
in this chapter if you want to move to another day or month. 

107 



Reference 

The Menu Bar contains various functions that you can perform in the Calendar program. 
The File Menu lets you open, dose, or print a file . The functions on the Text Menu 
let you record information on a selected day . Use the Date Menu to set the highlight 
on a particular day. Calendar also has help screens, scrolling arrows, and access to 
the Icon Bar. 

Calendar 

File Menu Text Menu Date Menu Help Scrolling Icon 

Arrows Bar 

Keyboard Techniques 

Use the standard keyboard techniques as explained in Chapter 2 of the Reference part. 
The keys listed below perform specific functions in the screen's calendar area: 

Press: To Move the Highlight: 

space bar Right one day 

(SHIFT JE) To the first day of the next month 

(SHIFT ( ::) To the first day of the previous month 
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To next January 

To last January 

Press C BREAK I while in the text area to return to the Calendar area. 

Press (BREAK l while in the Calendar area to exit the Calendar application. 

Edit text for the highlighted day by pressing c ENTER ) or by selecting e di t from the 
Text Menu. While in the text area, the standard keyboard techniques apply. 

Mouse/Joystick Techniques 

Use the mouse/joystick in Calendar as explained in " Getting Started." Note the 
following techniques for using the Menu Bar arrows: 

Point to: Then: To Move tire Highlight: 

G Double Click To the first day of the next month 

Double Click To the first day of the previous month 

Double click on a calendar day to move to the text area. You can also reach the text 
area by selecting the Text Menu and then clicking on e d i t. While in the text area, 
the standard mouse/joystick operations apply. 

File Menu 

Choose the File Menu when you want to open a Calendar file, close (save) the Calendar 
application data, print data, or see a help screen dealing with the File Menu. Each file 
contains schedules and information for the day or days for which you entered text. 
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s a v e 

<. I cs" 

2 t' I in 
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Opens any calendar file. Move to the Menu Bar and select F i l e. 
Choose open from the File Menu. A window appears showing the 
files (by name) contained in the highlighted folder. Select the folder 
(and file) you want and press I ENTER I or click. 

Saves file (by name) and you remain in the Calendar application. After 
you choose save from the File Menu, the message, 

S tt \ 0 a s: 

appears on the screen. Enter the filename you want to use and press 
!ENTER). 

Warning: You must have sufficient disk space before saving a file . 
DeskMate will not save a portion of a file, so if you receive a "Disk 
Full" message while attempting to "save" a file, you must first 
make room on a diskette for the file and then repeat the save 
process. 

Exits the calendar application and saves any entered or changed data. 
After you choose c I o s e from the File Menu, the message, 
s d v e' - yes no, appears on the screen. Select the option you want 
and press I ENTER I or click. 

Note: It is recommended that you use the "save" option before 
using the " close" option. 

Prints text for the current day, week, or month . You can also choose 
to print all text. Choose '-' r 1 n t from the File Menu. 

\I(.; e k 
J l l 



Calendar I 13 

Select the option you want and press I ENTER I. 

You can also use CAI:IX2)to print. 

? he l p Displays a help window 1esigned to assist with File Menu functions . 

Text Menu 

Choose the Text Menu to perform various functions for a selected daily record . 

3 copy 

4 insert 

Inserts a copy of the selected record into a copy buffer for you to use 
later. After you select a date to copy, choose co py from the Text Menu. 
The selected record is now in a buffer. Mark another day on which 
to copy the record and then choose in ser t. You can also use (A1:I)(]J 
to copy. 

Note: An I n s u f f i c i e n t Me mo r y message will occur if you 
attempt to copy more than 400 characters in the text area of 
Calendar. 

Inserts the record from the copy buffer into the selected daily record. 
You can use this function only if you placed a record in the copy buffer 
via the copy function, explained above. You can also use CAr:IJG) to 
insert. 

Note: An In suff i cient Memory message will occur if you 
attempt to insert more than 400 characters in the text area of 
Calendar. 
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5 delete 

7 find 

8 edit 
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Clears all information in the chosen daily record. You can also delete 
a range of dates. After you select delete, the message, 

Delete ~ one day mo re 

appears. Select an :>ption and press CENmr or click. If you choose 
more, the screen prompts you to enter a date range. Enter the 
beginning and ending dates for which you wish to delete information. 
CAJ:l)([) also deletes. 

Finds the first (or next) daily record containing information you specify. 

Find: -----

At the prompt, enter the text you want to see (up to 20 characters), 
and press I ENTER J. The first day containing the text you entered is 
highlighted, and the record of that date is displayed. To find the second 
day containing your specified text, select f ind again. The prompt and 
the text you previously entered reappear. Press I ENTER J, and the 
second day containing the text is highlighted. You can continue this 
process until you reach the end of your Calendar file. When you next 
use find, it will search from the beginning of the file. You can also 
use CillXD to find text. 

If you select this function, a cursor appears in the text area, and you 
can enter new information or edit existing information for the date 
currently displayed. If you use all the spnces (up to 400 characters) for 
every event you enter, you can store fifty days of events. 

Type and edit in the same manner as you do when using the Text 
application (but without the "select" and "block" features). See 
Chapter 14, " Text Editor", for more information. 

When you reach the bottom line of the text area, the screen scrolls up 
1 line so that you can always see the line on which you're typing. Use 
the arrow keys on the keyboard or the Command Bar arrows if you 
are using a mouse/joystick to scroll through the text. 

To exit the edit function, press CSBEAIO from the keyboard, or select 
ex i t from the Command Bar if you are using a mouse/joystick. 
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? help Displays a window designed to assist you with Text Menu functions . 

Date Menu 

Use the Date Menu to set the highlight on any valid date, or see help information about 
the Date Menu. 

,, ..• 
n 11 e 

9 f i n d d a t e Lets you set the marker on any valid date. Select f i n d d at e from 
the Date Menu. 

? he l p 

Date to Fi n d: --- - -

Specify a date to search for, and press I ENTER I. Normally, you' ll want 
to use a mm/dd/yy format when entering dates. However, if you 
wanted to find a date in 2001, you would need to use a mm/dd/yyyy 
format. The marker is then set on that date and the text information 
(if any) is displayed . CAI:.DCID also finds a date. 

Displays a screen of information to assist you in using the Date Menu. 

Help Window 

Use the help window when you need to know information about how to use the 
Calendar application. 
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Scrolling Arrows 

Use the scrolhng arrows in the Cale11dar application as explained in " Moving Around" 
in Chapter 11 of Reference. 

Icon Bar 

Select this function if you want to access the Icon Bar u tilities. See " Icon Bar Functions" 
in Chapter 12 of the Reference part for detailed information on the Icon Bar. 
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Text Editor 

Use the Text application as you would a typewriter and filing cabinet. Anything 
imaginable that you would ordinarily jot down, type, or record, you can now enter 
and save via DeskMate. Letters, memos, school reports, grocery lists, or even reminders 
to yourself can now be neatly and safely tucked away in a file . . . immediately 
accessible. You can even send any file you choose from the Text application to someone 
else through DeskMate's Telecom application. 

Instructions 

Choose the Text application from the Main Menu. 

A Menu Bar at the top of the screen contains the functions you can use in the Text 
application. The blank space on the screen is like a blank sheet of paper in a typewriter 
and displays 22 lines of text (if you are using a 40-column format) or 80 columns (if 
you are using an 80-column format). See " Display" in Chapter 12's " Icon Bar 
Functions" for instructions on how to change between 40 and 80 column formats. (If 
you switch format settings, Text Editor automatically adjusts the text to fit the new 
format.) You can begin entering text right away. Just type as you would on a typewriter . . 
Note that when you reach the end of a line, Text Editor automatically moves the word 
(or string of text) to the next line. 

Use the following methods if you need to edit your document. 

CAJ:IJG Backspaces, erasing the character over which you backspace. 

~([) Switches between upper/lowercase. 

CArnffi Switches between overstrike and insert. 
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T 3Xt Edito r 

File Menu Block Menu Find Menu Help Scroll Ing 

Arrows 

Icon 

Bar 

File Menu 

Use the File Menu for opening, closing, saving, merging, or printing text files or for 
seeing a help screen that explains the File Menu. Select the File Menu by using the 
mouse/joystick techniques or the keyboard. 

open 
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Loads a file from disk, replacing any document shown on the screen. 
Select a file from a menu of existing files that appears on the screen 
after you choose this option. 
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Exits the Text application and returns to DeskMate's Main Menu. You 
can choose to save or discard any edited text. 

Note: If you want to save the text you created, it is 
recommended that you use the "save" option (see below) 
before you close the file. 

Saves the contents of the text area or a block of text without leaving 
the text application. You can update the same disk file or specify 
another file name. 

Warning: You must have sufficient disk space before saving 
a file. DeskMate will not save a portion of a file, so if you receive 
a " Disk Full" message while attempting to "save" a file, you 
must first make room on a diskette for the file and then repeat 
the save process. 

Inserts a document from the current disk into the document on the 
screen. You can select the document to merge from a menu of existing 
documents, and it will be inserted in the open document at the current 
text cursor position. You can also use al:IJOJ to merge. 

Prints the entire document or a " block" select. (In a "block" select, 
only the selected block of text is printed.) You can also print by using 
CAll)(2). 
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' h elp Displays a "help" window designed to assist you with text file 
functions. 

Block Menu 

Use the Block Menu when you want to copy, insert, delete, or select text. Because 
the "block" actions all work with " selected" text, the select function is discussed first. 
{See "File Menu" if you want to print a selected block of text.) 

6 select 

3 copy 

118 

Keyboard: Position the highlight at the beginning of the text you want 
to select, and press Cill.XBJ, or use the Menu Bar {press CAI:IXJJ). 
Choose the Block Menu, and then the s e l e c t option. The Block 
Menu disappears, and you can move the cursor to select a block of 
text. {Moving up or down selects entire lines as they are passed.) The 
highlight's beginning and ending positions define the block. 

Mouse/Joystick: Choose the Block Menu, then the s e le ct option. 
Move the pointer to the beginning of the text to be selected and click. 
Hold down the mouse/joystick button for two seconds and then, while 
still holding the button, move the pointer to the end of the text you 
want to select. Release the mouse/joystick button. 

After you choose a block of text, you can copy, delete, print, or press 
(BREAK I to cancel the selection. 

Note: If you switch formats (40- or 80-column) when text is 
highlighted {or selected), it remains highlighted in the new 
format. 

Copies selected text to a buffer. You can then insert the buffer contents 
as many times in the text as you like by using the insert function . 
aJ:I)(]) also copies text. 



4 i n s e rt 

5 delete 

? he l p 
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Inserts copied text into your document. First position the highlight 
where you want the copied text to appear, and then select i n s er t . 
You can also use CAJ:I:)G) to insert text. 

Deletes selected text. If ) ·ou have selected no text, this function deletes 
the character under the cursor. You can also use CAJ:Im to delete. 

Displays a help window that provides specific instructions for the Block 
Menu. 

Find Menu 

Use the Find Menu to search for a word or phrase in your document or to replace 
a word or phrase with another. 

7 fin d 

8 c ha n g e 

Finds the first occurrence of a " string" of characters following the 
cursor location. When you select fi nd, enter a line of text, and press 
c ENTER J. Enter the text exactly as you want it to be found. For instance, 
to find ''on,'' you would first type a space then on, followed by another 
space. Typing nothing but o and n could find "font," " sonar," and 
so on. The cursor moves to the first occurrence. Choose find again 
to find the next occurrence. You can also type a new search string or 
edit the old one. CAI:IXD also activates find. 

Lets you specify a search string (as in find), followed by another string 
to be substituted. After finding the first occurrence, the corresponding 
page appears, and the screen asks whether you want to make the 
substitution. You can press c ENTER I to find the next occurrence of the 
same string. This process repeats until you reach the end of the file. 
Next, the first page of your document appears. ai::IXID also activates 
change. 
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Displays a window designed to assist you with Find Menu functions. 

Help Window 

Choose the help window when you need to know specific information on how to use 
the Text application. 

Scrolling Arrows 

Use the scrolling arrows in the Text application as explained in Chapter 11, "Moving 
Around" in the Reference part. 

Icon Bar 

Choosing this option displays the Icon Bar utilities. See " Icon Bar Functions " in 
Chapter 12 of the Reference part for detailed information on the Icon Bar. 
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EJ Filer 

The Filer application lets you easily store and quickly retrieve information. You can 
set up a customized "card" for each file you create and include any information on 
a card in any format you wish. You can also sort cards in a variety of orders or find 
any card in your file by setting up criteria the card must meet to be found. 

Filer consists of 4 basic screens: the main screen (the first screen you see when you 
choose Filer from the Main Menu), the format screen (for setting up the format of your 
cards), the insert screen (for adding cards to the file), and the view screen (for viewing 
and manipulating cards in the file). Each screen and its uses are discussed in separate 
sections. 

The Filer menu bars and menus are organized as follows: 

Filer 

Main Screen Format Screen 
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The Main Screen 

When you select Filer from the Main Menu, you see: 

. ...,.,.,.._ ~-() <.*>...., - Menu Bar 

File name window 

Blank cards 

The main screen resembles a file cabinet drawer filled with blank cards. After you enter 
a filename in the provided window, set up a format for your index cards, and enter 
information on those cards, each card on this screen is labeled with its most important 
information. You decide the information that will appear on the label as you use Filer. 

The Main Screen's File Menu 

After you name or choose a file you can select Fi le from the main screen's Menu 
Bar. When you select ~ • ., , you see: 
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Use the main screen's File Menu after you have defined a format and added data to 
your card file. This menu enables you to close the file and return to DeskMate's Main 
Menu, print the entire file of cards (or only cards you have " marked"-see the 
explanation of the main screen's Card Menu), or see a help window that assists you 
in using the File Menu. 

cl o ~ e 

2p ri n t 

? he lp 

Saves the file in its current state and returns to DeskMate's Main Menu. 

Prints marked cards, or if there are no marked cards, prints the entire 
card file, with each card's data. (See the explanation of marking cards 
in "The Main Screen's Card Menu" and the explanation of marking 
fields for printing in "The Find Screen.") You can also press CAU)C2) 
to print the file. 

Displays a help window designed to assist you in using the File Menu 
options. 

The Main Screen's Card Menu 

If you choose Card from the main screer{' s Menu Bar, you see: 

The view option is explained in its own section, later in this chapter. Generally, selecting 
the view option displays another screen that lets you manipulate the cards in your 
file and the information on those cards. 

The i n s !? r t option, like v i e w, is explained in another section of this chapter. It 
enables you to add cards to your file. 

Choosing the format option enables you to set up the way you want your cards to 
look or change a card format already set up. This option is explained in its own section, 
later in the chapter. 
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Other Card Menu options are: 

Removes all marked cards or the currently highlighted card (if no cards 
are marked) from the file. (See the explanation of the next option, 

· , to find out about marking cards.) You can also press CArnCID 
to delete cards. 

Lets you select 1 or more cards to print or delete. First, highlight the 
desired card on the main screen, and then mark it by choosing this 
option. Then, use either the : ,.. i ', function from the File Menu or 
the "t J · function from the Card Menu. You can also mark cards 
by pressing CAID'.]). 

Repeat the mark procedure to "unmark" a card. 

Displays a help window designed to assist you with the Card Menu 
options. 

The Format Screen 

Index Cards is set up so that when you create a new file, you move automatically to 
the format screen, as if you had chosen Card from the main screen's Menu Bar and 
then chosen the Card Menu's option. However, you can, once a file containing 
actual information exists, access the format screen by making the appropriate menu 
selections. You can set up a format, insert and delete fields from the format, or change 
the order in which you want to sort cards. 

A blank format screen for a file just being set up appears. 

Before you enter information on your file's cards, you must set up a format, a way 
you want the cards to look. The format screen enables you to define areas called fields. 
A field contains a unit of information that you want to include on your card (such as 
name or address). Each field consists of 2 parts: a label describing the information you'll 
enter, and a data area for actually entering the information. You can set up as many 
as 22 fields on 1 format. 
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Field Labels 

The left column of the screen is reserved for entering field labels. A label always begins 
at the left margin of the screeo. Type t maximum of 12 characters on 1 line to create 
a field label. When you press c ENTER to finish the label, any unused label area fills 
with dots and a colon, and you move to the data area on the same line. 

Data Area 

You can reserve more than 1 line for entering data. The data area on the same line 
as the label contains room for 25 characters. Each additional line contains space for 
37 characters. If you want additional lines in the data area, press CD for each extra 
line. Press c ENTER I when the data area for the field is as long as you need. The cursor 
automatically returns to the left margin of the next line so that you can enter another 
label. 

You can leave the data area totally blank so that when you enter information later, 
you can enter it in any manner you like. You can, on the other hand, further define 
the data area by using edit characters. Edit characters show that a certain type of entry 
is required, for example: 

P r. c, n f: n i.: ·1 ~H: r : 
D a~•' : 

( .. . ) . . . . .. . 
.. I .. I .... 

The edit characters in the example above are C, >, -, and I . After you enter the field 
labels and reserve the data area, move to the line on which you want to insert edit 
characters, and press CSHIEIB to move to the data area. Type the appropriate 
character(s}, and press c ENTER I when you finish. The cursor moves to the next field 
label. You can erase unwanted edit characters by pressing CAI:IX3 to backspace over 
the character you want to delete. 

When you later enter information in a data area containing edit characters, the cursor 
skips over all edit characters so that you cannot type over them. In the previous phone 
number example, the cursor would skip the opening parenthesis and immediately move 
to the first dot so that you could type the number's area code. 

Once you establish your format, you can alter it by using the format screen's Menu 
Bar. The Menu Bar on this screen contains options that let you alter the format or see 
a help screen that explains the format screen. 
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The Format Screen's Format Menu 

When you choose Format from the format screen's Menu Bar, you see: 

., 

,~ .. 
I l • 11: it 

' t , t• lp 

-- - . ---~ -
5 o e l e t e f i e l d Deletes the entire field (label and data area) at the current highlight 

position. Highlight the field you want to delete, and then select 
this option. The field disappears, and all fields below it move up 
the number of Jines the deleted field occupied. You can also use 
(ill)(]) to delete a field. 

!> o r t o rd e r Changes the order in which your cards are displayed on the main 
screen or on the view screen . DeskMate sorts cards by looking at 
the information in the first field on a card or by looking at the 
information in a field for which you set the primary priority. Filer 
sorts strictly alphabetically. In the case of numbers, the same is 
true. If your first field contained 1000, its card would sort and 
appear before a card containing 9 in its first field, because the " 1" 
in 1000 occurs " alphabetically" before "9". 
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Suppose that you arranged recipes in a card file by name and type 
(veal cordon bleu- entree, cherries jubilee-dessert, etc.). The 
recipes would be arranged in alphabetical o rder by the first field 
(name). To see the recipes arranged according to type, you would 
change the sort order to make "type" the #1 priority field. 

To change the sort ord er from Filer's default method of first field, 
second field, third field , etc., select s o r t c r tl e r from the Format 
Menu. The current sort order appears. The cursor moves only up 
and down through the assigned priority numbers. Next, type a 
number, 1-5, to assign a sorting priority to any field you like. (1 
is the highest priority, 5 the lowest.) All remaining numbers shift 
to allow for the new priority assignment. For instance, assigning 
1 to a field when another field already has first priority changes 
the other field's priority to 2, and so on. Finally, press c ENTER). 



exit 

? he l p 

Filer I 15 

Filer uses only the first 5 fields on the card or the fields to which you've 
assigned priorities 1-5 in sorting. Any remaining fields have no effect 
on the way your cards are sorted. 

Stores the format you set up on disk, and returns to the main screen. 

Displays a help window to assist you in using the Format Menu 
options. 

The Format Screen's Help Icon 

Choose the help icon from the format screen's Menu Bar to see general information 
about using the screen. 

The Insert Screen 

After a format exists for your cards, you are ready to enter data on the insert screen. 
To see this screen, select card from the main screen's Menu Bar. Then, select the 
Card Menu's inse rt option, or press CAl:l:)G). The screen shows the labels and the 
data area you set up on the format screen, and you can begin entering information 
in the fields. After you enter the data for the last field on the card, store the card's 
information by using the Menu Bar's Insert Menu. After the card is added, another 
blank card appears, and you can continue to add cards or use the Menu Bar's Insert 
Menu to exit the insert screen. 

The Insert Screen's Insert Menu 

When you choose In s ert from the insert screen's Menu Bar, you see: 
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.. ado 

? tie l p 

Adds the card on the screen to the file . Be sure that you highli3ht the 
:i <: d option, and press (ENTER l or click. You see another blank index 
card that you can fill in. Pressing CArnffi al~o adds the card. 

Lets you stop adding :ards and return to the main screen of Filer. If 
you have a card on t'. 1e screen when you select e / i t , that card is 
added before the exit actually occurs. When you return to the main 
screen, the cards you added sort according to the order you set up on 
the format screen. 

Displays a help window to assist you in using the Insert Menu. 

The Insert Screen's Help Icon 

Choose the help icon from the insert screen's Menu Bar when you want to see 
information to help you insert (add) cards. 

The View Screen 

When your file contains cards, you can use the view screen to see any of those cards 
or change information on them. To see the view screen, move the highlight to any 
card on the main screen. Next, select . . . from the main screen's Menu Bar. Then, 
select . · .. from the Card Menu or press c ENTER J. The screen displays the contents 
of the card you highlighted . You can view other cards or change the information on 
the displayed card. After you change information and display another card, the changed 
information becomes part of the card you edited. Use the scrolling arrows on the Menu 
Bar (explained in "Other View Screen Features") or the ~ and CSBIED3 
to display subsequent or previous cards. Anytime a card is on the screen, you can initiate 
a search for cards meeting certain criteria, delete the displayed card, or print its contents. 
These options are available to you through the view screen's Menu Bar. 
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The View Screen's File Menu 

When you select c i l ·~ from the view screen's Menu Bar, a window on the screen 
shows: 

~ ( i t Returns you to the Filer main screen. 

Enables you to search for specific cards in your file. This option is 
discussed in detail next. 

Displays a help window to assist you in using the view screen's File 
Menu. 

The Find Option. When you choose the f in d option from the view screen's File 
Menu, a new screen appears, showing a blank form in which you can enter criteria 
by which you want Filer to search. For example, if you were looking for cards for all 
people with the last name of Jones, you could type Jones at a Last Name field. 

You can use 2 special characters in the criteria you type: ? and *. ? tells Filer that you 
don't care what the character at that position is. Typing, for example, ?ANK in a field 
would let Filer match SANK, BANK, or TANK, but not FRANK. . 

* tells Filer that the character at that position and all subsequent characters should 
match. Typing A* in a field would let Filer match any word that begins with A. Typing 
*ANK would let Filer match any word at all in the field (or a blank field) because the 
first character is *, meaning that any number of characters of any type should match. 

* can also specify that you want to search for a certain string of characters. Typing 
*ARK* in a field would let Filer match DARKNESS, SHARKS, or ARK itself. Note 
that the first* you type in specifying a string must appear in the field's first character 
position. 

129 



Reference 

The criteria you enter is only the basis for the information you want to find. Using 
the Jones example, you could find all persons with last names occurring alphabetically 
before Jones, after Jones, or even equal to (the same as) Jones. When you decide to 
search for information less than, greater than, or equal to your search criteria, you are 
using a relational operator, an operat<lJ' ( <, >, or =) specifying a relationship between 
the information you type and the i1 formation you want to find. 

Selecting the F i n d option on the find screen's menu bar lets you further specify the 
search criteria you enter and perform other functions. When you choose F i n d from 
the find screen's Menu Bar, the screen shows: 

You can choose any of the first 3 options (the relational operators) whether you have 
already typed your search criteria or not. Type your search criteria either before or 
after you choose those options. 

The Find Menu's options are: 

1 les s 

2 g r e a t e r 

3 equ al 

130 

Specifies that you want to search for information less than the search 
criteria you enter in the currently highlighted field. You can also press 
CAJ:lXD to select l e s s . 

Specifies that you want to 5earch for informt1tion greater than the search 
criteria you enter in the currently highlighted field. You can also press 
CA1:lJC2) to select g r e a t e r . 

Specifies that you want to search for information equal to the search 
criteria you enter in the currently highlighted field . (If you do not 
choose l e s s , g re a t f:' r , or e qua I. , Filer assumes that you want to 
use e qua l.) You can also use CAJ:J:)(]) to select equal. 



7 find 

clear 

6 mark 

exit 

? help 

Filer I 15 

Activates the search through your file for any cards matching the search 
criteria (and relational operator, if you specified one). The Find Menu 
disappears, and the first card containing a field in which information 
matches your criteria appears. Use the scrolling arrows (explained in 
"Other View Screen J'eatures") or CSHirnB and CSHIFTIG to see 
either the next or pre· •ious matching card. Filer continues to display 
matching cards until you choose the c l ea r option on the Find Menu 
or return to the main screen. Pressing CAJ:I)CZJ also activates find. 

Clears all search criteria you entered from the find screen, and stops 
any search that might be ongoing. You can enter different criteria or 
choose the ex i t option from this menu. 

Toggles between marking (or unmarking) fields you want to print as 
cards are printed. Marked fields, which will print, appear with asterisks 
in the label area. Highlight the field you want to unmark, and then 
select this option. Filer marks all fields by default so that all the data 
on a card will print unless you specify otherwise. To print the card's 
information, see " The View Screen's Card Menu." You can also press 
CALI)@ to mark or unmark fields. 

Cancels your search instructions before the search begins, and returns 
to the display of the card previously on the screen. 

Displays a window to assist you in using the Find Menu options. 

The find screen also contains a help icon on its Menu Bar. Select this icon to see general 
information about the find function. 

The View Screen's Card Menu 

Choose Card from the view screen's Menu Bar to delete or print the displayed card's 
information. A menu window appears: 

... . ";' .. 
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' r. ' r ' 
' 

Deletes the currently displayed card from the file, and displays the file 's 
next card. You can also press CACOCID to delete a carci. 

Prints the currently displayed card. All fields on the card print unless 
you unmark (via lhe find screen's Find Men•J) certain fields. You can 
also press cm::Ja) to print a card. If you are currently searching, this 
function prints the currently displayed (matching) card and all 
subsequent matching cards. 

h c . :1 Displays a help window to assist you in using the Card Menu options. 

Other View Screen Features 

The view screen's Menu Bar contains 3 other features: a help icon and 2 scrolling arrows. 
Select the help icon to see information that assists you in using the view screen. The 
2 scrolling arrows, available only if you are using a mouse/joystick, enable you to display 
the next or previous cards in your file. 

Files that you may have created in the Color Computer 2 (Index Cards) version of 
DeskMate are automatically read and converted by this version of Filer. 
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Paint 

You might think of the Paint application as a blank canvas, with you as the artist. You 
can draw and edit on the screen, creating your own patterns or choosing from the 
patterns already available, using a number of available "tools." The resolution of Paint 
is 160x200, with 16 colors. A label line at the top of the screen contains 6 functions 
that you can use throughout the Paint program. (Three of the functions are specific 
to Paint, and the other 3 are standard DeskMate functions.) The remainder of the screen 
is for you to use in drawing. 

Instructions 

Select Paint from the Main Menu. 

Practice drawing on the screen for awhile, using the methods described next for the 
keyboard or the mouse/joystick. 

File 

Menu 

Palette 
Menu 

Paint 

Tool 

Menu 

Edit 
Menu 

Help Icon 

Bar 
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Keyboard Techniques 

Paint works best with a mouse or jciystick, but you can also use the keyboard. 

Use ~he arrow keys to move the pencil on the screen. (See " Moving Around" in Chapter 
11 of the Reference part for methods of moving the cursor more quickly.) Pressing the 
space bar once lets you draw in the canvas, and pressing it a second time " lifts" the 
pencil from the canvas. If you are using the keyboard with Paint, practice awhile to 
become more proficient. 

Mouse/Joystick Techniques 

Use the a e v 1 c e option in the Edit Menu to select the type of device being used . 

The " mouse or joystick" option works best when you want a fast, freehand movement. 
Use the joystick option when you want a slower movement that is good to draw steady, 
straight lines. 

To select a function with a mouse/joystick, use the techniques described in Chapter 
11, " Moving Around" in the Reference part. In the " canvas" area of Paint, the pointer 
actually resembles a pencil, and you can move it around in the same way. To draw, 
press the button on the mouse/joystick, and maneuver the mouse or the joystick control. 
When you move the pencil to the Menu Bar, it becomes a pointer, and you can make 
a menu selection. · 

134 



Paint I 16 

File Menu 

Choose the File Menu when you want to open, close, save, or print a file that you 
have created. 

open 

clos e 

sav e 

2print 

Loads a file from disk, replacing any drawing on the screen. Select 
a file you want to open from a menu of existing files on the disk. 

Exits the Paint application and returns to the Main Menu. You can save 
or discard the drawing on the screen. 

Note: It is recommended that you use the s il v ~ option before 
using the c lose option. 

Saves the picture on the screen without closing the Paint application. 
You can update the same disk file or specify another filename. 

Warning: You must have sufficient disk space before saving 
a file. DeskMate will not save a portion of a file, so if you receive 
a " Disk Full" message while attempting to "save" a file, you 
must first make room on a diskette for the file and then repeat 
the save process. 

Prints the screen in black and white or color. After you choose pri nt 
from the File Menu, you can select the method with which you want 
to print. 

dotmatr1x 
color ink iet 

You can print a black and white screen with most Tandy printers that 
can be used with your Tandy Color Computer. 
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' help 

You must have a color ink jet printer (CGP-220) to print in color. 

You can also use CAI:lJC2) to print. 

Displays a "help" wine ow designed to assist you with File Menu 
functions. 

Palette Menu 

Use the Palette Menu to select a color or pattern to be used in creating your masterpiece. 
The palette has 16 solid colors and 4 patterns. All four patterns in the Palette Menu 
can be edited. Move the highlight to the Menu Bar, and select Pa l et t e. 

After you choose a color or pattern, the Palette Menu disappears. You can use the 
colors and patterns you choose with these tools: pencil, brush, line, square, circle, spray, 
magnify, fill, solid square, and solid circle. 

Tool Menu 

Use the Tool Menu to choose a tool with which to apply the color or pattern. 

Pencil 

Eraser 
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The cursor is in the shape of a pencil, and you can perform 
freehand drawing using a single point in the current color. 

Erases portions of your drawing, using the current 
background color. 



Brush 

Line 

Rectangle 

• Ortlo 

Paint 116 

Uses the selected color and brush shape, and, like the pencil, 
lets you d ·aw freehand on the screen. 

The shape of the current brush defines-the cursor. Choose 
the brush shape from the Edit Menu's brush option. 

This tool draws a line between 2 points. After you select the 
first point, all possibilities are shown until you select the 
second point. 

Draws an outline of a box by using 2 selected corner points. 
All possibilities are shown until you select the second point . 

Draws an outline of a circle or oval by using a center you 
selected and then an x-y radius. All possibilities are shown 
until you choose the second point. 

This tool draws lines between two points. All lines begin 
at the first point selected. You must double click to exit the 
Rays option. 
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Ill 
II 
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Solid 
Rectangle 

Solid 
Circle 

Spray 

Magnify 

Creates a rectangle and fills it with the current color or 
pattern. 

Creates a circle and fills it with the current color or 
pattern. 

This tool "spray paints" with randomly scattered dots. This 
freehand painting is like drawing with a can of spray paint. 
Just hold down the Mouse/Joystick button while moving the 
cursor to "spray" the paint. 

Spray option uses the current color and brush shape. 

Magnifies a section of the screen that you select. You can 
draw on the magnified screen using the current pattern and 
brush shape to put the smalles t details in your picture, then 
return to the normal size to see the results. 

You cannot " undo" the last item drawn on a magnified 
screen. 

Fills an outlined area with the current pattern or color. 



Text 

Select 

Paint I 16 

Lets you ac d text to the graphics display using the keyboard. 

Selects an area on the screen by surrounding it with a dotted 
square. The options are: 

e r a s e Erases the selected area, using the 
current background color. 

c. u t & p ..is t e Places the selected area's image into a 
buffer and then erases it from the screen. 

c. o p y & past e Places the selected area's image into a 
buffer without erasing it from the screen. 

pa s t e Places the image in the buffer at the 
desired position on the screen. 

If you choose r as t e, there are two 
options available, transparent and solid. 

Transparent lets you place the buffered 
image on the screen by overlaying only 
the image and not its background. 

Solid places the entire selected area on 
the screen, erasing everything under it. 

Note: The buffered image 
remains intact even after another 
picture file is loaded from a disk, 
enabling you to copy images 
from one picture to another. 
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Pencil and Eraser are always single point operations. Brush, Line, Rectangle, Circle, 
Rays, Spray, and Magnify use the current brush shape. Solid Rectangle and Solid Circle 
do not use the brush shape. 

Edit Menu 

The 6 functions on the Edit Menu select brush shapes, erase the last thing added to 
a picture, dear the canvas, and modify patterns. 

Brushes 

Und o 

CL ear 

Pattern 

140 

~r ;-i.; , r ... •. ,,.:, r...i1 . t..>f:~l.;1 . -'~~'i<~'l'? ~ilao· 

·~run iTm 
r· 1.- .-.r 
Pdt tern J 
dr-1 1 1 ( _p 
._. hP IP 

Selects a brush shape. A window of brush shapes appears. Select the 
type of brush with which you want to paint. You return to your canvas. 
The following tools can use the brush shape you select: brush, line, 
square, circle, spray, and magnify. 

Erases the last thing drawn on the screen. 

Erases the entire content of the screen, using the background color you 
select. 

This function lets you define and edit your own pattern (8 x 8 pixels). 
When you choose Patte rn, the screen shows: 

Patterns 

Color Palelle 

r\_r_rr:t:.;_i:r .. .!•:, ,:. ~~1 -r~~n.M~~ .i:,J.'": ~•f!• 
1.. .. •.• ! .. , ..... ' 
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- - ·~ - II ---. .. ...... ----·- --- . ,,,. . 
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Dots (Pixels) 

Note: See this screen on the back cover of the manual for a 
true representation of colors. 



Paint I 16 

Each square on the pattern represents the smallest dot (pixel) on the 
screen. Follow the instructions below to edit the pattern. 

1. Keyboard: Press CAIIJCI), and then use the arrow keys to move 
to the pattern you want to modify. 

Press CArnCD after the selection is made to return to the pixel 
squares. 

Mouse/Joystick: Point to the pattern you want to modify and click. 

2. Keyboard: Press CAJ:l)G to move to the Color Palette, then use 
the arrow keys to choose a color. 

Mouse/Joystick: Point to a color on the Color Palette and click. 

3. Keyboard: Press ~ to return to the pixel squares, and then 
use the arrow keys to move the highlight to the square you want 
to change. Press the space bar. The square changes to the color 
you chose. The pattern you chose reflects the change. 

Mouse/Joystick: Point to the square you want to change and click. 
The square changes to the color you chose. The pattern you chose 
reflects the change. 

4. Continue changing the squares in the pattern until it looks the way 
you want it. 

5. Press (ENTER I (or point to I ENTER J and click) to record the 
changes. 

Press (BREAK I (or point to CBREAK J and click) to cancel the changes 
and return to Paint's canvas. 

6. Choose the Palette Menu from the Menu Bar to see the pattern 
you created. 
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D t: v 1 c e 

' help 

Selects the device you want to use with Paint. The options are, 
keyboard only, joystick only, or mouse/joystick. 

The "mouse/joystick" option works best when you want a fast, 
freehand movement. Use the joystick option when you want a slower 
movement that is gc od to draw steady, straight lines. 

Displays a help window designed to assist you with the Edit functions. 

Help Window 

This Menu Bar selection displays a help window designed to assist you with the Paint 
functions . 

Icon Bar 

Choosing this option displays the lcon Bar utilities. See Chapter 12, "Icon Bar 
Functions" in the Reference part for detailed information on the Icon Bar. 
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Ledger 

With the Ledger application, your screen becomes a spreadsheet divided into rows 
and columns. After you enter data and formulas, Ledger calculates the values for your 
formulas and automatically displays the computed values. You can type any text you 
wish, such as titles and headings, to give your reports a professional look. You can 
save the spreadsheet as a Ledger (or as a Text file to include in a document) after 
customizing it to meet your specific needs. 

You can set the resolution on your screen to a 40- or 80-column format by using the 
Display feature on the Icon Bar. See Chapter 12, "Icon Bar Functions" in the Reference 
part. 

The keyboard and mouse/joystick techniques for Ledger are the same as described in 
"Getting Started." Any variations are explained in this chapter. 
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Instructions 

After you select the Ledger application from the Main Menu, you see the spreadsheet 
screen. (If you select a Ledger data fil ?, you see the spreadsheet as you last saved it.) 

Cell 

The spreadsheet consists of columns and rows. There are 99 columns and 99 rows in 
which you can enter data in the Ledger application. The area at which a column and 
a row meet is called a cell. You will enter data in these highlighted cells. 

There are 3 types of data you can enter: 

number 

label 

formulas 

consists of the digits 0-9, an optional decimal point, and an optional 
sign ( + or - ) . 

consists of alphanumeric characters but begins with a character other 
than 059, +, - , or decimal point. 

for formulas to be used in calculations. 

The contents of the currently marked cell (number, label, formula, or empty cell) are 
identified at the bottom of the screen (cell I.D.) . The formula can have a maximum 
of 50 characters. In the 40-column format, the first 25 characters appear on the screen, 
followed by ffi if there are more characters (not shown) in the formula. In the 
80-column format, the entire formula is displayed on the Cell I.D. 
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To add data to the ledger, position the highlight on the desired cell, and type the data. 
When you move the highlight, the data that you entered remains in that cell. After 
you enter a number, it appears flush right in the cell (right-justified). Labels align to 
the left inside a cell (left-justified). 

Although the built-in column widti 1 is 7, you can enter up to 28 characters for a label 
and up to 18 digits (plus a decimal point and an optional sign) for a number (14 digits 
before the decimal point and 4 digits after). If you type more than 7 characters in a 
cell, the cells on the right of the current column shift by 1 character for each additional 
character you typed. Press c ENTER I or an arrow key to increase the current column 
width. All columns to the right are positioned accordingly. 

In addition to automatically widening a column to accommodate long cell entries, 
Ledger reformats numbers in the same column when you enter a number with a 
different decimal format. There are 2 reasons to reformat numbers so that they have 
the same number of decimal places and so that the greatest number of decimal places 
be used: 1) for maximum precision during calculation, and 2) for cosmetic purposes 
so that all numbers in the same column are aligned with the decimal point in the same 
position. 

For example, if numbers you previously entered in a column contained only 2 decimal 
places and you enter a number with the maximum of 4 decimal places, zeroes are 
automatically appended to the earlier entries. However, if appending additional decimal 
places to another number (other than the one currently being entered) increases the 
column width, you see * * * * * * * instead of the number with the extra zeroes. To 
display the entire number, increase the column width so that the new number with 
more decimal places can fit. 

Follow the instructions below to change the column width: 

1. Move the highlight to the column margin. 

Keyboard: Press CSBIEIXD to reach the column margin. 

Mouse/Joystick: Point to 0 on the Menu Bar and click twice. 

2. Move the highlight to the column you want to change. 

Keyboard: Use the G and 8 keys to move the highlight. 

Mouse/Joystick: Point to O or Q and click to move the highlight. 
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3. Select f or m a t from the Block Menu. The following prompt appears: 

Ch ange column width 'l 7 
' t his a ll c 0 l1...om ns 

4. Enter the setting and press CEJf:.'.EID. (The margins can be set from 3 to 28.) 

5. Move the check to the option you want ( t h i s or a l l co l u ~ n s ) and press 
(EJfFEJD or click. 

The .columns are adjusted automatically. 

Pressing (BREAK l at any time in Ledger cancels the operation you are in and returns 
any values you entered to their previous values. 

Ledger 

File Menu Block Menu Cells Menu Scrolling Arrows Icon Ba 
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File Menu 

When you select F i e from the JVenu Bar on Ledger's main screen, you see: 

open 

close 

s a ve 

Loads and displays a spreadsheet file . The file you open replaces the 
file in memory. Select the desired file from a menu of existing files that 
appears. 

Note: To store the information on the screen, save the file 
before opening another, since the ope r, function overwrites it. 

Closes the current file and returns to the DeskMate Main Menu. You 
are given the option of saving the current spreadsheet. If you answer 
yes, enter a filename if this is a new file or if you want an updated 
copy of an existing file as well as the original file. Press c ENTER I alone 
or click to save the spreadsheet under its existing filename. 

If you use c l o s e to save a spreadsheet, the spreadsheet is stored as 
a Ledger file. To save a spreadsheet as a text file, see save below. 

You can also press CB"fUrA"Xl at any time on the spreadsheet screen. 
Pressing c BREAK I works in the same way as choosing c l o s e . 

Note: It is recommended that you use the s ave option before 
using the c lose option. 

Saves all the current spreadsheet (all 99 rows and columns) as a ledger 
file or saves a selected portion of the spreadsheet as either a spreadsheet 
or text file. 
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1 merge 

2 print 
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To save an entire spreadsheet as a ledger file, choose the s ave function 
after entering the ledger data. Enter a filename or press c ENTER) alone 
to resave a spreadsheet. 

You may want to safe only part of a spreadsheet to use in a text file 
or to merge into anmher spreadsheet file . To save a partial spreadsheet 
as either a spreadsheet or text file, first define the portion of the 
spreadsheet you wish to save by using the ~ e l e c t function on the 
Block Menu, then use this function. (For example, you can first define 
the block by highlighting all cells you want to save.) 

When you choose save, you have the option of saving the partial 
spreadsheet as a document or spreadsheet file. Choose the file format, 
you want, and then enter a filename or press (ENTER l to save the 
spreadsheet under its old filename. 

Warning: You must have sufficient disk space before saving 
a file . DeskMate will not save a portion of a file, so if you receive 
a o i s k Fu l l message while attempting to "save" a file, you 
must first make room on a diskette for the file and then repeat 
the save process. 

Merges a partial spreadsheet file into the current file at the current 
highlight position. Select the desired file from a menu of files that 
appears. You can also use CAJ:IXI) to merge. All formula cells being 
merged are relocated and adjusted to correctly reflect the row or column 
rearrangement. 

Note: A complete spreadsheet cannot be merged into another 
spreadsheet file. 

Prints the entire file or a selected block of the current spreadsheet. Be 
sure that the printer settings are correctly adjusted before you print. 
You can also use CAI::Im to print. 

To print part of a spreadsheet, first define the portion of the spreadsheet 
you wish to print by using the s e l e c t function on the Block Menu, 
and then use this function. 
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To print the entire spreadsheet, select the pr i n t function . All columns 
and rows, which contain data, are printed. Blanks are printed for the 
empty cells between data cells. 

Displays a help windJw to assist you with the File Menu. 

Block Menu 

After you choose the Block Menu, you see: 

6 s e l e c t 

Keyboard: 

~.r.1 .. ~.t.~ ··•! ... _,.,. ,~_.;.li' ...:•ac•"' ·•v•" 

!'c::> pt,1 -
!> cit•lpt1• 
t~ ~ ••l.-c t 
~ hu·.,. uld 
? ····h· 

All Block functions work on a selected block of celJs or, if you select 
no block, on only the currently highlighted cell. To use a function on 
a single cell, first position the highlight on the desired cell, then select 
the function. To use a function on a block of cells, move the highlight 
to the first cell you want in the block, and then choose s e l e c t . Move 
the highlight to the last cell of the block, and then choose the desired 
function. You can also use CArn(]) to select. 

Note: If you switch format settings (40- or 80-column) while 
a cell or block of cells is highlighted, the selected cell(s) will 
also be highlighted in the new format setting. 

1. Place the highlight at the beginning of the block you want to select. 

2. Choose s e l e c t from the Block Menu or press CAI:IXID. 

3. Use the arrow keys to widen the highlight area until you include all desired celJs. 
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4. Choose the desired function from the Block Menu or press the desired CArn code. 

Mouse/joystick: 

1. Point to the beginning of the de ;ired block of cells, and click and hold. 

2. Drag until the highlight covers the area, and then release the button. 

3. Point and dick at the selected function on the Block Menu. 

Note: Any function not applicable for a selected block of cells appears 
shaded in the menu. 

After you define a block of cells by selecting it, you can use one of the following 
functions on it: 
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• • d • Changes the format of a selected block or the current cell (or the width 
of the current column or all columns if the highlight is in the column 
margin). 

To change the width of a column or all columns, move the highlight 
to the column margin. Position the highlight on the number of the 
column you want to change by moving to row 1, then ras::m::x::I), and 
then select the f " : . 'a t function. 

Change column width : 

To change the displayed width value, type the new value, and press 
(ENTER J. Type 0 before a width value less than 10. (For example, 03) 

Next, you are given the option of changing the current column only 
or all columns. Press '. ENTER J or click to change the width of the 
current column only. To change the width of all columns, press 6 
and (ENTER J, or point to A l l and click. 

To change the format of a single cell: Position the highlight on the 
desired cell, and then select the • l'l r m a t function. You can change 
the justification of a label cell, or both the justification and number of 
decimal places of a number cell. 
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After you select form a t, the format choices appear with the settings 
in which the cell is currently formatted. 

Justify 
Fract io n 

.<. 
Q 

1> 
2 3 4 

Press ..SEAC~ t o choose 
Pres s (E_N_TER to co ntinu e 

(You would see only the Jus t i f y option if the cell contained a label.) 
For the Justify option, you have 3 options: to left- or right-justify the 
contents of a cell, or to keep the current justification. For the numeric 
format option, you have 6 options: 0 (whole number or integer format}, 
1 (1 digit after the decimal point), 2 (dollar and cents format}, 3 
(3 decimal places), 4 (4 decimal places}, or keeping the current numeric 
format . 

Press the space bar to move the highlight to other format choices. If 
you press the space bar when the rightmost option is highlighted, the 
highlight temporarily disappears to indicate to keep the current format 
(leave the contents of the cell as is). 

Press ffi and QJ or move the mouse/joystick to move the highlight 
between the 2 format options. When you are finished and have 
changed the format in the desired manner, press (ENTER J to record 
the changes. If you've changed your mind and want to keep the 
previous cell format, press c BREAK J to cancel the changes. In either 
case, you return to the spreadsheet. · 

To change the format of a selected block: First define the block using 
the select function, and then choose the f o rm a t function. Then, 
follow the instructions above for changing the format of a single cell. 

Places the contents of a selected block or the current cell in the copy 
buffer. After copying the desired data, use the i n s e r t function to 
place the contents of the copy buffer in another area on the spreadsheet. 

If you need more memory space, you can copy an empty cell into the 
copy buffer, overwriting the contents of the buffer and allowing for 
more memory space. 
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You can also use CA.l):) ffi to copy . 

Inserts the contents of the copy buffer nt the current highlight position 
or inserts a blank c:olumn or row at the current highlight position (if 
the highlight is in < column or row margin). You can also use CAIJ:X!) 
to insert. 

Note : You can enter data into 99 rows on the spreadsheet, so 
if you insert a blank row when the spreadsheet aiready contains 
99 rows, the last row (and data, if any) is overwritten by the 
blank row. 

If a you are inserting data from the copy buffer into a row or column 
containing data, the previous data is overwritten by the new data and 
is no longer accessible. If you are creating a blank row or column, the 
data and formula originally in that row or column (and all subsequent 
rows or columns) shift down or to the right one row. Row and column 
numbers in formulas also "shift" so that the same values are used in 
calculations. All formulas are adjusted to correctly reflect the row or 
column insertion . 

If, while you are inserting a row or column, a form ula does not refer 
to any valid cell in the spreadsheet, the cell I.D. line displays 

. For example, suppose that in cell R2C1 you entered the 
formula, R99+ 1. You then moved the marker up one cell, then to the 
row margin and inserted (using ( AL T) ) a new row. Your formula 
would move to R3C1, but it would become invalid, as it would then 
read R 100+ 1. 

Erases the contents (labels, numbers, and formulas) of a selected block 
or the current cell. You can also use~ to delete. To delete an 
entire column or row, move the highlight to the desired column or 
row number in the margin area, and then select the ' function . 
ALI formulas are adjusted to correctly reflect the row or column deletion . 

Enables you to enter a formula for the current cell or selected block. 
You can also use CAI:D CID to enter a formula . 
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To enter a formula for a single cell, position the highlight on the cell 
where you want the calculated value to be displayed, select the formula 
function, type the desired formula, and press (ENTER I. (You can also 
edit an existing formula for a cell in the same way.) 

To enter a formula for'-· selected block of cells, define the cell block 
by using the · · function, select the formula function , and then 
enter the formula . If you copy a block of cells that contains a formula(s) 
into another location on the spreadsheet, the formula(s) that you copy 
is adjusted to reflect the column and row numbers of the new location . 

Within a formula, mathematical operations are performed from left to 
right. Parenthetical operations are performed first, functions like SUM, 
second, power third, multiplication and division fourth, and addition 
and subtraction last. When parentheses are nested , the innermost 
operations are performed first. The operations available for use in 
formulas are in the following table. 

Formula Operations 

between 2 cells: 

+ Addition 
Subtraction 
Power 

• 

for a row or column 

AVG Average (mean) of the values 
MAX Maximum value 
MIN Minimum value 
SUM Sum of the values 

ABS Absolute value 
INT Integer truncation 

for a cell 

S IN 
cos 
TAN 

Multiplication 
Division 

Arguments are 
in 

Degrees 
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Following are examples of formulas using some of these operations. 

AVG(C1) Adds all the values in the current row, beginning with 
column 1, over to the current cell, skipping any non
numeric data, and divides by the number of numeric 
cells added. 

MAX(C4) Displays the maximum value of the current row, 
beginning with column 4, over to the current cell, 
skipping an y non-numeric data. 

MIN(R1) Displays the minimum value in the current column, 
beginning with row 1, down to the current cell, skipping 
any non-numeric data. 

SUM(RS) Displays the sum of the val ues in the current column, 
beginning with row 5, down to the current cell, skipping 
any non-numeric data. 

ABS(R2C3) Multiplies the value of the cell in row 2, column 3 by 
-1 if (and only if) it is a negative number (absolute value). 

INT(R4C2) Displays the integer value of ct'll R4C2. 

R1C1 + R3C4 Adds the value of cell R1C1 to the value of cell R3C4 
and displays the result. 

Two special characters can also be used in a formula: a question mark 
(?) indicates a constant value that you need to enter at the time of 
calculation. For example, if a cell formula is entered as / ,. , then when 
the calculation function is selected, you' ll be prompted to enter a value 
for ~ so that computations can be completed . 

Displays a window designed to assist you with the Block Menu. 
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Cells Menu 

When you choose the Cells Menu, you see: 

7 .: '"1 .J 

" • 3 c .. .• : 

? r. ~ l p 

I ~ l®Zll c i 11 ;.· 

~., h~lp 

•fl (1 I.) {) u ~) 

Finds a particular cell label. You can also find a formula . 

A window appears with the p rompt: 

Enter the number of the cell (in R#C# format) or the string of characters 
you wish to find. The window containing that cell is displayed with 
the entry marker on the specified cell. To find the next occurrence 
of the same search string, reselect the · ! function, and then press 
(ENTER l or click the mouse/joystick button . 

You can also use CAI:OCD to find . 

Calculates and d isplays the results in the cells in which formulas were 
entered . Data is calculated according to cell contents, from left to right 
and top to bottom. Any non-numeric data is skipped . If you have 
entered a formula that cannot calculate, the message, 
appears. 

If an "overflow" (too many digits) occurs in a recalculation, the cell 
containing the formula d isplays • • · , · r· ~ ' < • ~ 

You can also use CArnCID to calculate. 

Displays a help window designed to assist you with Cells Menu 
functions. 
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Help Window 

Displays a window designed to assist you with Ledger functions. 

Scrolling Arrows 

Use the scrolling arrows as explained in Chapter 11, " Moving Around," in the 
Reference part. 

Icon Bar 

Displays the Icon Bar utilities . Refer to " Icon Bar Functions" in Chapter 12 of the 
Reference part for more detailed informa tion . 
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!:;] 
~ Telecom 
Telecom lets you convert your Color Computer into a communication device called 
a tem1i11al. As a terminal, your computer can communicate with other computers by 
sending and receiving information. The information can be displayed on the screen 
in a 40- or 80-column format that you choose from the Display function on the Icon 
Bar. (For more information, see Chapter 12, " Icon Bar Functions" in the Reference part. 

To use the Telecom application, you need: 

• Another computer with which to communicate 

• Additional equipment for your Color Computer so you can connect it to another 
computer 

Telecom lets you communicate with any computer that has: 

• A program for communicating with small computers 

• Equipment for connecting to small computers 

The program the other computer needs can foll into either of these categories: 

• A " host" program- This kind of program lets a computer make its resources 
available to terminals. Examples of host programs are information services, 
host operating systems, and simple host programs (such as the Host application 
for the Tandy 1000 DeskMate program or a public bulletin board system). 

• A terminal program- This kind of program converts a computer into a terminal. 
The Telecom application described in this chapter is a terminal program. Other 
examples of terminal programs are the COMM program for the Tandy Model 4, 
the TELCOM program for the Tandy 100 and 200, and the Videotex program 
available for many Tandy computers. 

157 



Reference 

The equipment the other computer needs depends on the kind of equipment you are 
using. You can connect your computer to the other computer in two ways. Each way 
requires that you purchase different kinds of communication equipment: 

158 

• Over a telephone, using a small-computer modem (such as the Tandy DC
Modem I), the Color CompL•ter RS-232 Pak, and an RS-232 cable . 

This connection requires the other computer to have a modem compatible with 
the modem you are using. Note that you must plac~ the RS-232 Pak in Slot 
1 of the Multipak Interface and the disk controller Program Pak in Slot 4. 

• Through a cable, using the Color Computer RS-232 Pak, an RS-232 cable, and 
a Null Modem Adapter. 
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This connection lets you transmit information at much higher rates of speed 
than you can use over the telephone. It requires the other computer to have 
a standard RS-232 connection interface. 

Be sure that all your equipment is turned off while you are making connections and 
setting up. Then, when all the e. 1uipment is ready to work, turn on the Multipak 
Interface before you tum on the Color Computer. 

A Note to Customers Using the RS-232 Pak 

The RS-232 is a standard that you can use to connect a computer to a modem or a 
computer to another computer. This means that, in theory, you should be able to use 
the RS-232 Pak for connecting the Color Computer to modems and computers from 
manufacturers other than Tandy. 

In practice, however, the connection between a Tandy RS-232 and another 
manufacturer's RS-232 will sometimes not work properly without having a technician 
readjust wires on the RS-232 cable. This is because manufacturers sometimes implement 
the RS-232 standard in different ways. For technical information on how Tandy 
implements the RS-232 standard, see the manual that comes with the RS-232 Pak. 

An Overview of Telecom 

Telecom has 3 screens. They are: 

• The Status Screen-This screen lets you set up Telecom for communicating 
with another computer. 

• The Termjnal Screen-This screen lets you connect to and communicate and 
exchange files with the other computer. 

• The Memory Screen-This screen lets you do 3 things: 1) access the information 
that has been communicated, 2) exchange a file with the other computer, or 
3) exit Telecom. 
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Following is an example of how you would use the Telecom screens in communicating 
with a host computer. 

1. Use the status screen to prepare for communicating with the host. 

2. Use the terminal screen to conn ?ct to, logon, communicate, and logoff from the 
host. 

3. Use the memory screen to view the information that has been transmitted and, 
if you want, save or print this information. 

Telecom 

Status Screen Terminal Screen Memory Screen 
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Instructions 

At the Main Menu, select Telecom. 

Status Settings 

The menu bar contains the familiar DeskMate icons as well as options for displaying 
two menus. 

• The View Menu lets you move from screen to screen and is available from all 
the Telecom screens. It is described below. 

• The other menu (in this case, the File Menu) contains functions unique to the 
screen you are using. It is described in the section dealing with the particular 
screen. 
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View Menu 

Select Telecom's View Menu, which is available from all the Telecom screens . 

5 m c- mo r Y Displays Telecom' s memory screen. Pressing CAIJ)(ID also displays 
the memory screen. 

6 t e :- rn 1 ., a l Displays Telecom's terminal screen . Pressing aI!J(ID also displays 
the terminal screen. 

7 sta t us Displays Telecom's status screen. You can also use CAL:IXD to display 
the status screen. 

? he l P Displays a window designed to assist you in using the View Menu. 

The Status Screen 

Before communicating with another computer, you need to tell Telecom how it should 
transmit information to that computer. The status screen lets you do this by adjusting 
a number of settings. 

For your convenience, the status screen also contains a File Menu. This menu lets you 
store your status settings on diskette so that you won't need to set them each time 
you communicate with another computer. 
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Move to the status screen. You see the status settings that Telecom is currently using. 

For most of the settings, Telecom offers a choice of settings and highlights the setting 
it is currently using. To change a setting, simply select the new setting by positioning 
the highlight and pressing (ENTER J •>r clicking. 

For e)(ample, for the Line Feed setting, Telecom offers the choice of ON or OFF and, 
with highlighting, indicates that this setting is currently OFF. To change the setting, 
select ON. 

The us e .. Key 8 and Us e r Key 9 settings are purely for your convenience and are 
described below. To enter these settings, select the desired line, and type the 
information, pressing c ENTER J when you finish. For example, if your user ID were 
75005, you could select User Key 8 (by moving to that line and pressing (ENTER J or 
clicking) and type 75005 c ENTER l to preset your user ID. 

The status settings and their meanings are: 

User Key 8 and User Key 9-These settings are not required; they are strictly for the 
convenience of customers who usually log on to the same host computer and find it 
tedious to enter their user IDs and passwords (or other information) each time. 
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If you are one of these customers, you can enter anything that you usually have to 
send to another terminal when you log on and use the status screen's File Menu to 
save this information with the rest of your status settings. Then, when you enter the 
terminal screen and log on to the host, you will no longer need to physically type and 
enter that information-you can have Telecom send it automatically. 

Serial Port-Always check this setting before communicating with another computer. 
It defines the communications driver used in Terminal mode. U you are using an RS-232 
Pak, type rr2 at this prompt. If you have other drivers connected and know their 
descriptors, you can specify the appropriate descriptor at this prompt. 

Caution: Do not type anything at the Serial Port prompt if you have no 
communications device connected to your computer. 

Baud rate-Always check this setting before communicating with another computer. 
It tells Telecom how fast to transmit information to the other computer. The higher 
the baud rate, the faster the transmission. 

• If using an external modem, you must choose a baud rate that your modem 
can use. The other computer must also use this same baud rate. 

• If using the RS-232 Pak connection, you can use any baud rate provided that 
the other computer also uses this same baud rate. 

Word size, Parity, and Stop bits-Always check these 3 settings before communicating 
with another computer. They have a technical meaning that tells Telecom how to code 
the information it transmits to and receives from the other computer. 

You can use any combination of these 3 settings provided that the other computer uses 
the same combination. Most computers use one of the following combinations: 

Word size 
Parity 

711 7/2 8/1 8/2 
even odd none 

Line feed-Adjust this setting if you have a line spacing problem. It tells Telecom 
whether to add an extra line feed to each carriage return character{! ENTER I character) 
that it receives from the other computer. 
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With most computers, you can use the OFF setting (no extra line feed) . If, however, 
the lines you receive from another computer are displaying on top of each other, you 
need to change this setting to o N. 

Echo-Adjust this setting if ycu are having a problem with the way Telecom is 
displaying the characters you t} pe. It tells Telecom whether to echo (display) or not 
echo (not display) your characters. 

If the characters you type are displaying in duplicate, change this setting to o F F. If, 
on the other hand, your characters are not displaying at all, change this setting to o N. 

When communicating with most host computers, you will find o F F to be the best 
setting. When communicating with other " terminals" (such as another computer 
running Telecom), you will find ON to be the best setting. 

Ascii Filer-Strips all characters over 7F hex and control characters other than line feed , 
carriage return, backspace, tab, and formfeed. 

Wordwrap-lf you are displaying data on the screen in memory mode and the word 
(or characters) cannot be displayed fully in the current line, it will be displayed in the 
next line. 

The Status Screen's File Menu 

Select the Status Screen's File Menu. This menu lets you store your current status 
settings on diskette as a Telecom file. 

ope ,, Loads a Telecom file from diskette. Telecom displays a list of all the 
Telecom files you currently have stored on diskette. From this list, select 
the file you want to load. 
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: l OS e 

sav e 

' help 

Exits Terminal mode and returns to DeskMate's Main Menu. You have 
the option of saving or discarding the current status settings. 

Note: It is recommended that you use the sav e option before 
using the c l o s 1· option. 

Saves the current status settings on diskette as a Telecom file. 

Warning: Make sure that you have sufficient disk space before 
saving a file . DeskMate will not save a portion of a file, so if 
you receive a D i s k F u l l message while attempting to "save" 
a file, you must first make room on a diskette for the file and 
then repeat the save process. 

Displays a screen designed to assist you in using the status screen's 
File Menu. 

After storing your status settings in a Telecom file, you have the option of entering 
Telecom using this file. For example, from the DeskMate Main Menu, you could enter 
the file for a particular status. This would cause Telecom to automatically start up, load 
those status settings, and go directly to its terminal screen. 

The Terminal Screen 

To communicate with another computer, you need to be in the "terminal mode." When 
you move to the terminal screen, Telecom enters this mode and lets you send or receive 
information with any device to which you are connected. 

For the convenience of customers who must log on to a host computer, the terminal 
screen contains a User Menu. This menu lets you send a preset user ID and password 
(or other information) to the host computer. 
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Move to the terminal screen. The screen you see is, for the most part, blank. 

The steps for using this screen to communicate with another computer are: 

1. Connect to the other computer. 

2.- Communicate with the other computer. 

Also, although this is not a function of the terminal screen or, for that matter, the 
Telecom application, you might find it necessary to physically disconnect your modem 
from the telephone when you finish communicating with the other computer. 

Connecting to the Other Computer 

The way you need to connect to the other computer depends on the kind of 
communication equipment you are using. 

External Modem: If you have not already done so, connect your modem to your 
computer and to a telephone. Then, follow the steps in your modem manual for 
connecting to the other computer. 

If your modem is an autodial modem, the steps outlined in your manual might involve 
your sending commands to your modem. 

RS-232 Cable: If you have not already done so, connect the two computers. Then, 
if the other computer has not yet entered its terminal mode, it should do so now. This 
is all that is required to make the connection. 

Communicatiitg With the Other Computer 

You should now be able to communicate with the other computer as a terminal. As 
a terminal, Telecom sends each character you type to the other computer and displays 
each character it receives from the other computer. 
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The Memory Screen's File Menu 

Select the memory screen's File Menu. This menu lets you perform several tasks that 
can be grouped together in 3 genera categories: access the storage area (Save, Print, 
Erase, Open), exchange a file with the other computer (Send, Receive), and exit Telecom 
(Close). When you select the memory screen 's File Menu, the screen shows: 

OPE"' 
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Loads a DeskMate Text file into the memory file. Telecom displays a 
list of all DeskMate Text files you currently have stored on diskette. 
From this list, select the file you want to load. 

Exits Telecom. In case you have not yet saved the contents of the 
memory file, Telecom asks: 

ye s , n o 

If you do not want to save the contents of the memory file, select no. 

To save the memory file as a Text file, select yes. Telecom prompts: 

Sav e as : 

In response to this prompt, enter a name suitable for a DeskMate Text 
file. 

Note: It is recommended that you use the save option before 
using the c lose option. 



sa ve 

er a se 

2pri nt 

Telecom I 18 

Saves the contents of the memory file on diskette as a DeskMate Text 
file. Telecom prompts: 

Sav e a s : 

In response to this pr .:>mpt, enter a name suitable for a DeskMate Text 
file. 

Warning: Make sure that you have sufficient disk space before 
saving a file . DeskMate will not save a portion of a file, so if 
you receive a Di s k Fu L l message while attempting to "save" 
a file, you must first make room on a diskette for the file and 
then repeat the save process. 

Erases the contents of the memory file . Telecom asks if you are sure 
you want to do this by displaying: 

Erase mem o ry ' .~J yes L no 

Select yes if you are sure, or choose no if you change your mind . 

Prints the contents of the memory file . Telecom displays: 

Print t"_, a l l [; this page 

Select a l l to print the entire memory file. Select this page to print 
only the contents of the current screen. Pressing a:i::IX2) also activates 
the p rin t option. · 
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8 send Sends a file to the other computer. Telecom displays: 

Ent er extension to use: 

If the file you want to s1~nd is a DeskMate file, enter one of these 
extensions: 

Text file: 
Index Cards file: 
Ledger file: 
Paint file: 
Telecom status file: 
Calendar file: 

DOC 
FIL 
WKS 
PIC 
DMC 
CAL 

lf the file is an 05-9 file (that is, if it is not a DeskMate file), enter the 
OS-9 extension to the file's name. 

After you enter the extension, Telecom displays a list of all the files you have stored 
on diskette with that extension. From this list, select the file you want to send. 

9 r eceive Receives a file from the other computer. Telecom displays: 

Receive as: 

Enter a name suitable for a Desk.Mate Text file in response to this 
prompt. 

Telecom displays a message when it is ready to receive the file: 
Receiving. Press (ENTER l or enter the characters the service requires 
you to use to begin the file transmission . (The keys you press are not 
echoed on the screen.) 

To send (upload) or receive (download) a file to or from, for example, a computer 
service, prepare for your transfer on the tem1inal screen. Then, move to the memory 
screen and select the send or rec e i v e option from the File Menu. 

Note: You can also send and receive files from the Terminal Screen. 
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Press c BREAK l to close and complete a received file. (A sent file finishes automatically.) 
You know transmission is complete when the light on the disk drive turns off and 
the Writing message does not appear for some time. Any other key codes you press 
during the Receive function will be transmitted. 

For both Send and Receive, when Teh:com transfers the file, it transmits the information 
directly to or from the diskette. This means that you will not see the information being 
transmitted on your screen, nor will Telecom store this information in its memory file. 

The file you transfer can be from any Desk.Mate application or from a program other 
than DeskMate. If, however, the file is not a text file, you need to be sure that you 
have the status screen's word length set to 8 bits. (With text files, it doesn't matter 
which word length setting you use.) 

When Telecom receives a file, it saves the file as a Text file unless you enter the extension 
of another DeskMate application. (See the list of extensions earlier in this chapter.) 

For the transfer to work, the other computer must recognize the "start/stop characters" 
(XON and XOFF). Additionally, the other computer cannot use any special "protocol" 
for transferring the file other than what it might refer to as the "start/stop" (XON/XOFF) 
protocol. 

? he l p Displays a screen designed to assist you in using the memory screen's 
File Menu. 
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Error Messages 

If Desk.Mate does not seem to be working properly, first make sure that your disk system 
is properly connected and turned on. Be certain that you turned on all peripheral devices 
before turning on the computer. 

Refer to the following list of error messages if one appears on your screen. The error 
messages and their probable causes are listed in alphabetical order. 

Can't fi n d file o r d isk i s wri t e p r ote c ted 

A function was unsuccessful because the file was not found or because the disk 
was write protected. 

Ca n't f ind x :DM x x xx ... 

The file for which status was requested was not found . 

Can 't f i t da ta here 

During an insert or merge in Ledger, the contents of the copy buffer would not 
fit in the selected location (for example, copying a large block near the last column 
or row). 

Ca n't OPEN de st in at io n disket t e 

05-9 would not allow the Main Menu to access the destination diskette in a backup. 
The diskette must be a properly formatted 05-9 diskette. 
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Can't OPEN or READ source fi l e 

05-9 could not successfully open or read the source file in a Main Menu copy 
operation. 

Can ' t ·open or read this f ol der 

05-9 could not find or could not read the selected folder. To correct, either change 
the definition of the folder using the Icon Bar folder function, or replace the diskette 
with one that contains the correct folder. 

Can ' t READ or VERIFY d e st. di s k 

During a backup, the Main Menu was unable to verify that the the destination 
diskette was correctly copied. 

Can ' t WR ITE destination f il e 

05-9 could not successfully write data into the destination file in a Main Menu 
copy operation. 

Can ' t WRITE t o de st. disk 

During a backup, the Main Menu could not write any data to the destination disk. 

De s t. disk i ni t i a l iz ed incorrect ly 

In a backup operation, the destination diskette was not formatted or was formatted 
incorrectly. 

Des t. disk NOT reliab l e 

A backup attempt in the Main Menu was unsuccessful. 
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Destination disk does not conta i n DeskMate. Copy c ance lled' 

The destination diskette in a single disk copy must contain the DeskMate programs. 

Destination folder not found or d i sk is write prot ected 

The copy function in the Main Menu could not find the destination folder, or it 
could not write to the destination file because the disk is write protected. 

Device error 

A print function error. Make sure the printer is online and properly connected. 
If printing to another device (text file) be sure that device is defined in the printer 
parameters (Printer function on the Icon Bar). 

Di rector y not found 

The folder function in the Icon Bar could not find the directory that you specified. 
You are given the options of creating the directory or canceling the edit. 

Dir.ec t or y not found or di sk is wr ite protected 

An attempt to swap execution directory to a non-existent directory, or to swap 
onto a write-protected diskette. · 

Disk drive error 

Any input or output error on disk operations (save, open, close, merge, or execution 
of a program). This error can result from the disk being write-protected. 

Disk is full, can't copy file 

A copy attempt in the Main Menu was unsuccessful because of insufficient disk 
space. 
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Disk is full . Can't receive f i l e . 

An attempt was made to receive a file that is too large to fit on the disk (Telecom). 

Disk i s full. Save dat a o n an o t 1e r d is k! 

An attempt was made to write data to a full disk. Data was not successfully written; 
it is necessary to insert another disk to save the data. 

Disk is now ful l 

The disk is now full. Index Cards will automatically update the current record and 
return to the Index Cards screen. The file must be copied to another diskette. 

Di s k i s writ e p r otected 

An attempt to initialize a write-protected diskette. 

DMAPP S wa s n o t f o und o r wa s mis read . Pre s s an y key t o e xi t . 

The Main Menu cannot find DMAPPS file, which it must have to operate. To correct 
the error, copy DMAPPS from your master diskette or repeat the backup procedure 
from the master diskette to create a new working DeskMate diskette. 

DM x xxx ••• i s n't in eith e r pr o g ram f ol de r 

After opening a selected p rogram, the Main Menu could not find the program in 
either program folder. Replace the diskette with a diskette containing the program, 
then select the swap function. 

ERROR - Di s k in unknown st a te , u s e at o wn r i s k. 
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Err or occ•J rred opening RS232 dri vc r Can 't open ter mi n al mode> 

Serial fOrt hardware is not properly installed. The error occurred while opening 
the RS232 driver. The program can' t open the terminal mode. 

Fi lt! ex ist s , ove rwrite it? 

This is a warning that a file is being copied to an existing file. You have the option 
to cancel the copy function. 

File Fu ll 

An attempt was made to insert too many cards in one-Index Cards file. 

Fi lenaMe mus: be 1-8 character!; , beg i n with a - z, and con tain a-z 
o r 0-9> 

Illegal characters are in your specified filename. The filename must be 1-8 characters, 
beginning with a-z, and contain a-z or 0-9. 

Fo lder s and fil es are id e n t i cal , is thi s a si ng le di sk copy?> 

An attempt was made to copy a file to itself. This is only accepted if the source 
and destination files are on different diskettes (a single disk copy). · 

Form at not f oi...nd . Disk NOT i n it ialized• 

The Main Menu program could not find the 05-9 "FORMAT" program during 
an initialize function. 

For mat is: hH:MM:SS AM o r PM 

An incorrect time format was entered. 
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Format i s : "I M/ 0 0 /Y Y 

An incorrect date format was entered. 

ll lc ga l o ;r e c r o r y ram e 

You specified an illegal 05-9 pathname. 

l ~co:n r.at • b le fi l e 

An attempt was made to load an invalid Ledger, Calendar, or a Filer record. 

An attempt was made to run the Index Cards program when the disk was full. 
The Filer program requires a small amount of free disk space to execute. 

An attempt was made in the text area of the Calendar application, to insert or copy 
more than 400 characters . 

• i . • e . ' l e r n u , a no t f o:;n d 

The find function cannot find the specified label or formula. 

Ne Ma t ch 

The search data was not found in any card. 
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No t € r· o u g ' • a ..., .,, v r v 

(1) There is not enough room for the program's data. 
(2) There is not enough room for an insert, copy, or merge operation. 
(3) The program or graphic! screen doesn ' t fit. 

If this message occurs while adding data to a file, try emptying the copy buffer 
(by selecting and copying a single character) to free more memory. 

P at h n ame not toun d 

(1) 05-9 can't find the specified pathname. 
(2) The specified pathname is illegal. 

R S 2 3 2 d r • • e r e r r C' :· 

Telecom received an error from the 05-9 serial device driver during a send or receive 
operation. 

Source d1:. k bJd sectc r s : 

During a backup operation, portions of the source disk were unreadable. 

You selected a program or data folder that contains no DeskMate files. To correct, 
select another folder or replace the diskette with one containing data and perform 
a swap operation. 

U s e ' ' 1 : ' ' o r ' ' 2 : ' ' t o s p ,, c i f y a d a t •J ' o l ".l e r 

When typing a filename, you entered an invalid folder number. 
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'. I I r (.J ~; , . a:;") 

While using the Main Menu copy function, an illegal folder number was specified. 
Use "1:", " 2:" for data folders, <•r "3:", " 4:" for program folders. 

A printer variable was entered that is either too big or too small. 

Be sure to use the proper methods to exit the DeskMate programs. If you remove your 
DeskMate diskette at any point other than the Main Menu, you may lose your data . 
If, for any reason, the program exits and returns to the 05-9 prompt, turn everything 
off and start over. 
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The OS-9 0 1>erating System 

An operating system is a computer program that provides basic input and output 
services (such as keyboard input and video screen output) to an application program. 
Operating systems also keep track of disk files by allowing you to save files by name. 

DeskMate is an application program that runs on an operating system called 05-9. 

Loading DeskMate Programs from the 
OS-9 Command Line 

DeskMate contains several programs to handle tasks such as text editing, scheduling, 
and calculating. You can access these component programs individually, without using 
the DeskMate Main Menu. 

To access DeskMate programs directly from the 05-9 command line, you must override 
the feature that allows DeskMate to auto-start. After entering 05-9, the operating 
system looks for a file called "AUTOEX," a nd if it exis ts, it is accessed immediately. 
To prevent this, fi rst allow DeskMate to auto-start, a nd then: 

1. Select from the File Menu on the Menu Bar. 

2. At the 05-9 prompt, type: 

RENAME /00/CMDS/AUTOEX D ESKMATE CENTER ) 

This changes the na me of the AUTOEX file to DESKMATE. 

At this point, there are 2 ways you can access DeskMate programs. From the 05-9 
command line, you can: 

1. Type DESKMATE CENTER J. The DeskMate Main Menu appears. 
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2. Type DESK DMnxx (where DMxxxx is any of the DeskMate program filenames). 

This lets you directly access any DeskMate program without using the Main Menu. 
To see the actual filename of a DeskMate program, use the Main Menu's s tatu s 
function . DeskMate programs begin witr the letters "DM." 

You can follow the name of the program you want to execute with the name of a data 
fi!e, using the usual DeskMate filename standard (1: or 2: followed by a name of no 
more than 8 characters). If you do not specify 1: or 2:, the default is 1:. For example, 
to access the Text Editor application with a file named SA M f' LE from DeskMate folder 
1, you would type DESK DMTEXT l:SAMPLE ce1rran. 

The technical description of what takes place is that the OS-9 shell executes a process 
(program) called DESK, which is the DeskMate parent process. Desk, in turn, loads 
and executes the program named in the second field (DMTEXT in the example above). 
DMTEXT then loads or creates the file named ,. A ~ 1 P I E. 

When you access a program in this manner, closing the program causes the OS-9 
prompt line to reappear. 

OS-9 Directories 

A directory is a file kept on the disk by OS-9. It contains the names and beginning 
disk sector numbers of other files. DeskMate uses this multiple directory concept to 
define its folders; however, DeskMate recognizes only DeskMate files . (If a Folder is 
empty message appears, the folder does not contain DeskMate files, but might contain 
05-9 files.) 

05-9 keeps 2 directories active at one time. One is called the " data" directory. This 
directory usually contains access to data and procedure files. The other is called the 
"execution" directory. This directory contains access to executable files (programs). 

186 



The 05-9 Operating System I B 

DeskMate uses this execution directory frequently for accessing help files and icon bar 
functions, and for returning to the Main Menu. Many t;mes, directories with the same 
name on different disks begin at different sectors, and if DeskMate is to access these 
functions mentioned above, the disk operating system must know at what sector the 
execution directory begins. This is done by using the "swap" function in the Disk Menu 
of the Main Menu's Menu Bar, o·· use the "CHX" command from OS-9's shell. When 
you use a separate program diskette with DeskMate, be sure to use the swap command 
in the Main Menu before opening any file. 

Deleting a directory is not the same as deleting an ordinary file. All files within the 
directory must be deleted first. (A file in a directory can be another directory.) To delete 
a dir·ectory, first replace your DeskMate diskette with an 05-9 system diskette, and 
use the "DELDIR" command. 
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Help with Telecom 

This appendix contains a list of problems you might encounter when using Telecom 
as well as possible reasons and solutions. The end of the appendix contains a chart 
listing the codes that Telecom recognizes. 

You cannot transmit any i11fonnation to the other computer. 

Telecom is unable to use your communication equipment to connect to the other 
computer. This could be because of any of these reasons: 

• Your communication equipment is connected improperly. Follow the instructions 
in the owner's manual for your equipment for connecting it, and try the connection 
again . 

• You set your modem improperly, or you are using the wrong sequence for making 
a modem connection . Follow the instructions in your modem manual, and try the 
connection again. 

• You are not at Telecom's Terminal screen . Move to the Terminal screen, and try 
the connection again . 

• The other computer is not set up properly for communicating. Have the other 
computer set up properly, and try the connection again. 

You receive many strange characters from the other computer. 

Telecom and the other computer are probably using different baud rate, word length, 
parity, or stop bit settings. Move to the Status screen, change Telecom's settings to 
match those of the other computer, and return to the Terminal screen. 
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You receive occasional st range clzaracters from the other computer. 

You are probably receiving nonstandard characters from the other computer that 
Telecom does not recognize. Find out if you can have the other computer adjusted 
so that it will no longer send yours the ;e nonstandard characters. (The characters that 
Telecom recognizes are listed at the f nd of this appendix.) 

The transmission between you and another computer "hangs up." 

Either Telecom, OS-9, or the other computer transmitted a ~CID and, by doing 
so, stopped transmission. To resume transmission, press CC:Dll:)(ID. If pressing 
~CID does not work, disconnect from the other computer, and try the connection 
again. 

If you encounter this problem repeatedly, it might be because you are exiting the 
Terminal screen (for purposes other than file transfer) while letting the other computer 
continue to transmit information to you. This causes OS-9 to automatically attempt 
to stop transmission by sending a ~CID character to the other computer. 

The lines you receive are displaying on top of each other. 

Telecom and the other computer are handling the carriage return (CENTER J) character 
in different ways. Move to the Status screen, set Telecom's Line Feed to ON, and return 
to the terminal screen. 

Tire lines you receive arc double spacinf?. 

Telecom and the other computer are handling the carriage return (CENTER l) character 
in different ways. Move to the Status screen, set Telecom's Line Feed to OFF, and 
return to the Terminal screen. 

The characters you type are displaying in duplicate. 

Both Telecom and the other computer are causing your computer to "echo" (display) 
the characters you type. Move to the status screen, set Telecom's Echo to OFF, and 
return to the Terminal screen. 
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The characters you type are not displaying. 

Neither Telecom nor the other computer is causing your computer to "echo" (display) 
the characters you type. Move to the status screen, set Telecom's Echo to ON, and 
return to the Terminal screen. 

You cannot transfer files to or from tile off.er computer. 

Telecom and the other computer are probably using different file transfer methods; 
for the transfer to work, both computers must use the same method. 

XMODEM and Telecom can use is the start/stop method. Using this method, Telecom 
transfers the file using no special characters other than~' for stop transmission 
(also referred to as "XOFF"), and CCJ'.fil:Xa', for start transmission (also referred to 
as "XON"). 

Codes recognized by Telecom appear in the following chart. 

Printed Keyboard Printed Keyboard 
Dec I ma I Hex Binary Character Character Dec I ma I Hex Binary Character Character 

0 00 00000000 2 1 15 00010101 CTllL U 
t 01 00000001 -.Cllll. A 22 16 00010110 ccnn:v 
2 02 00000010 "CTm. B 23 17 0001011 1 ccm.i;JW 

3 03 00000011 CTJ!'["C 24 18 00011000 CCI.BJ:jX 

4 04 00000100 '"C'l]fLD 25 19 00011001 f'Cm:;Y 

5 05 00000101 ct:J'J\!" E 26 1A 00011010 :t::rm::z 
6 06 00000110 ..c.mLF 27 10 0001101 1 

7 07 00000111 (CT.m:"G 28 1C 00011100 

8 08 00001000 backspace _CIJU.:H 29 10 00011101 

9 09 00001001 tab ctmCI 30 1E 0001 1110 

10 OA 00001010 line loed CCTM:J 31 1F 00011111 

11 OB 00001011 :cJ.M:K 32 20 00100000 ~ACEBA/i) 

12 oc 00001100 form feed '.:C.'mt:"L 33 21 00100001 

13 OD 00001101 carnage return rcmL.M 34 22 00100010 

14 OE 00001110 cc.im.N 35 23 0010001 1 ' ' 15 OF 00001111 ~CT!tCO 36 24 00100100 $ $ 

16 10 00010000 CC1Bl::P 37 25 00100101 % % 

17 11 00010001 XON '"C1m"'O 38 26 00100110 & & 

18 12 00010010 CCJFI.-A 39 27 00100111 

19 13 00010011 XOFF C'f'R[ S 40 28 00101000 

20 14 00010100 ~LT 41 29 00101001 
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Printed Keyboerd Printed Keyboerd 
Declmel Hex Blnery Chenicter Chanlcter Dec Imel Hex Blnery Chanicter Chanicter 

42 2A 00101010 76 4C 01001100 L L 

43 28 00101011 77 40 01001101 M M 

44 2C 00101100 78 4E 01001110 N N 

45 20 00101101 79 4F 01001111 0 0 
. 46 2E 00101110 80 50 01010000 p p 

47 2F 00101111 81 51 01010001 a a 
48 30 00110000 0 0 82 52 01010010 R R 
49 31 00110001 83 53 01010011 s s 
50 32 00110010 2 2 84 54 01010100 T T 

51 33 00110011 3 3 85 55 01010101 u u 
52 34 00110100 4 4 86 56 01010110 v v 
53 35 00110101 5 5 87 57 01010111 w w 
54 36 00110110 6 6 88 58 01011000 x x 
5S 37 00110111 7 7 89 59 01011001 y y 

S6 38 00111000 8 8 90 SA 01011010 z z 
57 39 00111001 9 9 91 50 01011011 ccniJ.:8 

58 3A 00111010 92 SC 01011100 ccmc::; 
59 30 00111011 93 so 01011101 ~T.El.tJ9 

60 3C 00111100 < < 94 SE 01011110 cc.mt:JZ 
61 30 00111101 95 SF 01011111 cc:rru;:_ 
62 3E 00111110 > > 96 60 01100000 <:e.m:@ 

63 3F 00111111 1 1 97 61 01100001 a A 

64 40 01000000 @ ~Slffi'T"@ 98 62 01100010 b 0 

65 4 1 01000001 A A 99 63 01100011 c c 
66 42 01000010 0 0 100 64 01 100100 d 0 

67 43 01000011 c c 101 65 01100101 e E 

68 44 01000100 0 0 102 66 01 100110 F 

69 45 01000101 E E 103 67 01100111 g G 

70 46 01000110 F F 104 68 01101000 h H 

71 47 01000111 G G 105 69 01 101001 I 

72 48 01001000 H H 106 6A 01101010 J 

73 49 01001001 I 107 60 01101011 k K 

74 4A 01001010 J J 108 6C 01101100 L 

75 40 01001011 K K 109 60 01101101 m M 
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Printed Keyboard Printed Keyboard 
Decimal Hex Binary Character Character Decimal Hex Binary Character Character 

110 6E 01101110 n N 119 77 01 110111 w w 
111 6F 01101111 0 0 120 78 0111 1000 x x 
112 70 011 10000 p p 121 79 01 111001 y y 

----
113 71 01110001 q a 122 7A 0111 1010 z z 
114 72 01110010 A 123 76 0111 1011 ccmJ:J< 
115 73 01110011 s s 124 7C 01 111100 crnc1 

116 74 011 10100 T 125 70 01111 101 CCIBIJ> 
11 7 75 01110101 u u 126 7E 01111 110 ~ 
118 76 01110110 v v 127 7F 01111 111 
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Displayable Key Codes 
Normal With CSHirn With (CIBIJ Normal With CSHIE]') Wlth(mlJ 

0 0 F 

G g 

2 H h 

3 I I 

4 s J 

5 % K k 

6 & L 

7 M m 

8 N n 

9 0 0 

p p 

+ 0 q 

< R 

s s 

> T 

I ? \ u u 

0 v v 

A a w w 

B b x x 

c c y y 

D d z z 

E 8 
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Quick Reference Key Chart 

Application Keys Used With CArn 

1 2 3 4 5 6 7 8 9 

Main Menu Print Copy Delete Rename Status 
Sort - - -Data 

Calendar Print Copy Insert Delete Find Edit 
Find - -
Date 

Text Editor Merge Print Copy Insert Delete Select Find Change 

Index Cards 

(a) Main Screen - Print Insert - Dele te Mark - - -
(b) View Screen - Print - - Dele te - Find - -

(c) Format Screen 
Dele te 

- - - - Field 
- - - -

(d) Insert Screen - - - Add - - - - -
(e) Find Less Greater Equal - - Mark Find - -
Pain t - Print - - - - - - -

Ledger Merge Print Copy Insert Ol'le te Select Find 
Calcu-

Formula 
late 

Telecom 

(a) Status - - - - Memory Terminal Status - -
(b) Memory - Print - - Memory Terminal Status Send Receive 

User User 

(c) Terminal - - - - Memory Terminal Status Key Key 
8 9 
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Starting OS-9 from BASIC 

If you do not have a Color Computer with Disk Extended Color BASIC version 1.1 
or later of if you do not have the OS-9 System, you can type in the following program 
and use it to start DeskMate. 

Using a formatted diskette other than your DeskMate diskette, enter the following 
program from Disk Extended BASIC. 

1~ RE I.I • • *•"' • 
20 REM • 1:001 OS - ? r~ ,p,1 B.\ S JC 
~~RE~,,,._ • • 

t.~ fOR 1=0 TO 7 C 
Sli'. PEAi) AS 
60 P O KE Stt5~00 • I , VAl (''~H' • Ai) 

7 0 :i tx ; I 
3 ~ c Ls : p ~ I NT , , I N :.. L RT \) s J D I s ,. ET r r . , 
9 ~ ~ q I ~. T , , I ~ T l l [) ;.. I v E ,, A N ~I t) f. [ s s A K E y I I 

1 0 1• \ ! -: I N _ Y $ : ! f A 1 :. '' '' T 't t N 1 0 0 

1 11 r x r ~ ~ 1tSC1J" 

1 .- " " ~ T A .; o , l_ ,> , f< t , ; • C• , ~ f. . "l) , I/I Cl 

1 7, ,, ~ ; : A F l , .: 6 , If ,) , • 1· , ~ ~ , 1• , 'J ' 

i..r Df• 'A 2c ·" ' · ' ~ ,<6.~ I • . ,54 
SJ DA - A 20 , 1~ . L.CC,.6,A t , 22 

16 .t DATA 86,02,A7 ,A t.,~ F ,21 , 6F 

P') IJATA 2 5,6C,23 , Af , 24, h'l , BL 
18~ UAT A CC , ~6.A6,23,8 1 ,1~ . 27 

190:JA ' I\12 ,A D, 'lr ,cc,J • •• ~'.>,27 

200 !::~T A ~6,6C,?3,c'.C , ?:. - "",F9 
21~ Ot.H 7F,F~,t. 0, 3c:,At , <iF,2~ 

2 . ~ :•A i \ r8 

Type the following instruction at the OK prompt to save the above program: 

SAVE "*" (ENTER) 
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F I Starting OS-9 from BASIC 

Type the following to use this program to start the application: 

RUN * CENTER) 

When the prompt appears, insut the DeskMate diskette and answer the date and 
time prompts. 
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Glossary 

backup. A duplicate copy of a diskette that is kept for recovery purposes in case the 
original is destroyed. 

baud rate. The speed (in bits per seconds) at which data is transmitted from one device 
to another. 

block. A group of characters selected for a specific purpose. 

byte. A group of 8 bits of information, processed by the computer as a single character 
or instruction. 

cell. The intersection of a column and row in the Ledger spreadsheet. 

click. Quickly pressing and releasing the button on the mouse or joystick. 

computer service. A service (such as Dow Jones News Retrieval Service and 
CompuServe) that provides a communications package to the computer user. 

copy (file) . A duplication of a file contained in DeskMate. 

copy buffer. A portion of data that is temporarily stored in memory and can be copied 
to another area of the application. 

cursor. A flashing indicator on the screen that marks your current position. 

cursor control. The method used to move the cursor (highlight) around on the screen, 
either mouse/joystick or keyboard. 

database. A file of information on a particular subject. 

default. A value that is assumed when none is specified. 

directory. A file containing information concerning the other files on a diskette. 

drag. Moving information on the screen by pressing and holding down the button 
while moving the mouse or joystick in the desired direction. 
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Glossan; 

echo. A setting in Telecom that lets you adjust the way Telecom is displaying the 
characters you type. It tells Telecom whether to echo (display) or not echo (not 
display) your characters. 

field . A defined screen o r file area that is used to store a unit of information. 

field label. Indicates the beginning and end of a set of data. 

filename . A set of characters used to identify a file. 

folder. A directory on the diskette that contains DeskMate program and/or data files. 

format. Preparing a diskette to hold DeskMate programs or data. (Also called 
initializing.) 

highlight . A portion of the screen shown as reverse video or outline that marks an 
application or option for selection. 

host computer. The operating computer that transmits the host program to terminals. 

host program. A program that lets a computer make its resources available to terminals. 

icon. A figure (drawing) that represents a DeskMate application or function. 

initialize. Pre paring a diskette to hold DeskMate programs or data. (Also called 
formatting.) 

insert mode . A function that lets you insert characters that you type into the text, rather 
than type over them. 

key field . The priority field when performing a sort function. 

line feed . A setting in the Telecom application that lets you adjust line spacing. It tells 
Telecom whether to add an extra line to each carriage return character that it receives 
from the other computer. 

log off. To cease communications with the host program (via Telecom). 
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Glossary 

log on. To begin communicating with the host program (via Telecom). 

merge. A function in DeskMate that inserts a document or a piece of a document from 
the current disk into the document on the screen. 

modem. A device that enable! 1 computers to communicate over telephone lines. 

network. Communications channels designed for use with the Telecom application. 

operating system. A group of programs that manages the flow of information in the 
computer. 

overflow. A condition that occurs when the result of an operation exceeds the capacity 
of storage. 

overstrike mode. A function that lets you type over a character, changing the former 
character to the one you typed . 

parity. A Telecom synchronizes the flow of information between computers. 

pathname. Gives directions to DeskMate and 05-9 on how to find an existing directory 
or where to put a new one on the disk. 

pixel. Short for picture element. A pixel is the smallest division of the video screen 
that can be turned on or off or set to a color. 

point. Moving the mouse or joystick until the tip of the pointer rests over the desired 
object. 

pointer. A small arrow on the screen that can be moved with a mouse/joystick to select 
(highlight) options on the screen. 

relational operator. A symbol that designates a comparison between two pieces of 
information. For example, > (greater than) is a relational operator. 

select. Choosing a function or application in DeskMate by highlighting (or pointing) 
and then pressing the button on the mouse/joystick or (ENTER l on the keyboard. 
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Glossan; 

serial port. A hardware connector through which sequential data (from a printer, 
modem, etc.) is transmitted and received . 

sort priority. The primary order of a field that tells DeskMate (Filer application) how 
to arrange information in a file. 

spreadsheet. A screen layout for the Ledger application that contains 99 columns and 
99 rows in which you can enter data. 

stop bit. A setting that separates elements of information during transmission . 

string. A group of characters in a sequence that is used in DeskMate to search for specific 
information. 

terminal. A keyboard monitor or a computer from which an operator can communicate 
with another computer via a program (such as Telecom). 

utility. A program in DeskMate that performs a frequently need task, such as copying, 
printing, etc. 

XOFF. The characters used to stop transmission in Telecom. 

XON. The characters used to begin transmission in Telecom. 
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Index 

! 153 
.. 129, 153 
"overflow 155 
+ 144, 153 
I 153 
< 130 
> 130 
- 130 
40-column format 99, 101, 144, 168 
80-column format 6, 39, 74, 99, 101, 

144, 168 
? 129, 154 
? help 

for File Menu 109-111, 118, 123, 
129, 131, 136, 149, 166, 175 

for Text Menu 113 
for Date Menu 113 
for Block Menu 119, 154 
for Find Menu 120 
for Card Menu 124, 132 
for Format Menu 127 
for Insert Menu 128 
for Edit Menu 142 
for Cells Menu 155 
for View Menu 162 
for User Menu 170 

ABS 153 
ALT ii 
appendices i, 177-200 
arrow keys 82 
Ascii Filer 165 
ASCll filter 71 
averaging expenses 66 
AVG 66, 154 

background 21-22, 101 
backspace 115 
backup 9-12, 91 
baud rate 97, 164 
Block Menu 38, 118, 149 

block select 117 
brush 137, 140 
buffer 118 

calculating totals on a spreadsheet 65 
Calculator utility 24-26, 97 
Calendar application 1, 29-33, 107-114 

Date Menu 113 
entering 30-32 
exiting 33 
File Menu 109-111 
finding entries 32 
Help Window 113 
instructions 107-108 
keyboard techniques 108-109 
Menu Bar 108 
mouse/joystick techniques 109 
printing from 32-33 
Text Menu 111-113 

cancel option 95 
Card Menu 43-45, 123-124, 128, 

131-132 
cell, spreadsheet 65, 144-145, 149-154 
Cells Menu 155 
choosing the device 7 
circle tool 137 
clear 131, 140 
close files 47, 49, 58, 87, 110, 117, 135, 

147, 166, 172 
color palette 23, 99, 102 
color scales 23 
Command Bar 112 
communications See Telecom 

application 
computer service 70, 72, 168 
connecting equipment for Telecom 2 
connecting, to the other computer 167 
control characters 165, 169 
conventions i 
copy 87-88 
copy and paste selected areas 88, 139 
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Index 

copying 
diskettes 3, 9-17 
files 87-88 
formulas 64-65 
See also copy 

creating a mailing list 41 
cursor control devices, See Keyboard; 

Mouse/Joystick 
cut and paste selected area 139 

data area, Filer Format screen 125 
data directory 186 
data diskette 15 
data files 15 
data folder 90 
data, searching for 

Calendar 32 
Filer 48-49 

Date Menu, Calendar 113 
delete 88, 112 
delete field 126 
deleting a card 47 
destination 10, 12, 15 
device 7-8, 134, 142 
directories, OS-9, 185-187 
directory of folders 94-95 
Disk Extended BASIC 5, 195-196 
Disk Menu 91 
diskettes 

copying 3, 9-17 
destination 10, 12, 15 
formatting 9-16 
source 10-12 
See also data .diskettes 

Display utility 99 
done option 95 
Dow Jones Retrieval Service 168 
download files 174 
drawing 51-53 

Echo 165 
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edit 95 
calculator utility 31 
Folder utility screen 94-95 
Filer application data 46-47 
text 37-38 

edit characters 125 
Edit menu 140 
Erase files 173 
eraser tool 137 
error messages 177-184 
exiting 

Calculator utility 98 
Calendar 33 
DeskMate 87 
Files Menu 89 
Folder Menu 91 
Filer 47 
Ledger 68 
Paint 58 
Telecom 75 
Text Editor 40 

field labels 125 
fields 124 

See also delete field 
Fil extension 174 
file extensions 175 

names 87-88 
opening 87, 110, 116, 135, 147, 165, 

172 
program 87-90 
sending 174 
status 89 

Filer application 1, 41-49, 121-132 
Format Screen 124-127 
Insert Screen 127-128 
Main Screen 122-124 
Menu Bar 122 
View Screen 128-132 

Files Menu 
Calendar 109-111 



Filer 122-123, 129-131 
Ledger 147-149 
Main Menu 87-90 
Paint 135-136 
Telecom 165-166, 170-175 
Text Editor 116-118 

fill tool 139 
find date 113 
find option 112, 129, 131, 155 

See also find date 
Find Menu 48-49, 119-120 
Folder icons 81 
Folder Menu 90 
Folder utility 94-95 
foreground 21, 101 
format option 9, 146, 150-151 
formatting diskettes 9-12, 15 
formulas, spreadsheet 64, 144, 152-153 

copying 64-65 
invalid 152 
operations 153-154 
writing 63-64 

functions 
selecting with keyboard 81-82 
selecting with Mouse/Joystick 83-84 

getting started in DeskMate 3 

hand-held calculator See Calculator 
Help With Telecom 188-194 
host programs 157 

icon ii, 6 
Icon Bar Functions 7, 21-22, 24, 26, 81, 

93, 105 
initializing diskettes 9, 11, 13-14, 91 
insert 115, 119 
Insert Menu 127 
insert mode 31, 35, 83 
Insert screen 127 
insufficient memory 111 

INT. 154 

Joystick See Mouse/Joystick 
justify 151 

Keyb)ard 
to access Menu Bar 86 

Index 

and calculator utility 24-26, 97-98 
and Calendar 108-109 
copying files with 9-12 
and cursor control option 104 
deleting files with 88 
editing text with 37-38 
to format, copy diskettes 9-12 
and Filer 41 
and Help Windows 105 
and Ledger 143-145 
moving around screens with 81-83 
and Paint 51-53, 133-134 
selecting folders with 90 
selt>cting icon bar with 93 

key chart, quick reference 194 
key codes, displayable 193 

labels, spreadsheet 144, 152 
Ledger application 1, 59-68, 143-156 

Block Menu 149-154 
Cells Menu 155 
File Menu 147-149 
Help Window 156 
Icon Bar 156 
instructions 144-146 
Menu Bar 145 

Line Feed 164 
loading deskmate 3, 5 
log off 73 
log on 72 
lower/uppercase 83 

M+ 25, 98 
M - 25, 98 
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Index 

magnify tool 138 
mailing list, creating 41-49 
Main Menu 85-93 

bypassing with 05-9 command line 
185-186 

manual conventions i 
mark 124, 131 
MAX 154 
MC 25, 99 
Memory Screens, Telecom 159, 171 

File Menu 172-173 
Menu Bar 81, 83, 86 

Calendar 108 
Filer 121 
Ledger 145 
Main Menu 86 
Paint 133 
Telecom 161 
Text Editor 115 

merge 117 
military 99 
MIN 154 
modem 72, 158 
Mouse/Joystick 

and calculator utility 24-26, 98 
and Calendar 109 
changing spreadsheet column 

width with 145-146 
copying files with 11-12, 14-15 
and cursor control option 104 
editing text with 37-38 
formatting, copying diskettes with 

11-12, 14-15 
and Filer 41 
and Help windows 92 
moving around screens with 83-84 
and paint 134 
selecting folders with 90 
used to access Menu Bar 86 

MR 25, 99 
Multipak Interface 158 
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Null Modem Adapter 158 
numbers, spreadsheet 144, 152 

Open files 87, 110, 116, 135, 147, 165, 
172 

operating system See OS-9 Operating 
System 

OS-9 Operating System 5, 94, 185-187 
starting from BASIC 195-196 

overstrike mode 35, 115 

Paint application 1, 102, 133 
Edit Menu 140-142 
File Menu 135-136 
instructions 133 
keyboard techniques 134 
Menu Bar 141-142 
mouse/joystick techniques 134 
Palette Menu 136 
Tool Menu 136-140 

Palette Menu 136 
Parity 164 
password 163, 166 
paste selected areas 139 
pathname 94 
pencil tool 136 
pointer 83, 134 
print 132, 135, 148, 173 
printer 5, 96 
printing 

from Calendar 32 
from Ledger 68 
See also print 

Quick Reference Card ii 

rays 138 
receive files 174-175 
rectangle 137 
reference i, 79 
rename 89 



renaming data files 77 
Resolution 100 
RGB Color Scales 22, 102-103 
RS-232 Pak 158-159, 164, 167 

sample sessions 19 
save files 110, 117, 135, 14;·, 166, 173 
screen colors 21 
scrolling arrows 92, 114 
search criteria 130 
search string 119 
select 118, 139, 149 
send files 69, 174 
Serial Port 164 
solid rectangle 138 
sort data 91 
source diskettes 10, 12 
spreadsheets 144 
status of files 89 
Status Screens, Tekom 159 
string of characters 119, 129 
SUM 154 
swap 92 

Tandy DC-Modem I 158 
Tandy Model 4 157 
Tandy 100 157 
Tandy 200 157 
Tandy 1000 DeskMate 157 
Telecom application 1, 69-75, 157-175 

characters recognized by 169 
communicating 73 
equipment requirements 2, 69, 

157-159 
exiting 75 
getting ready to call 71-72 
going offline 73 

Menu Bar 71 
printer settings 173 
View Menu 162 

terminal program 157 
Terminal Screens 159, 166, 169 
text 139 

Index 

editing See Text Editor application 
Text Editor application 1, 35-40, 115, 

120 
Block Menu 118-119 
File Menu 116-118 
Find Menu 119-120 
instructions 115 

time utility 27, 99 
Timeout 171 
Tool Menu 54, 136 
TfY 168 
two-drive system 12 
typing text 83 

upload 174 
user ID 72, 163, 166 
User key 8 163, 170 
user key 9 163, 170 

View Menu 161-162 
view option 123 
View screen 128 

window borders 101 
word size 164 
Wordwrap 165 
writing a letter 35 

X-MODEM 171 
XOFF 169, 175 
XON 169, 175 
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